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Change Management
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D%

As a repository is developed it will become the data store for valuable organizational information assets, and it is
imperative that this data is protected and maintained. Enterprise Architect has sophisticated tools to ensure the
information is protected, including full integration with all the leading Version Control Systems, Baselines that are
snapshots of your model that can be taken at important milestones, and Auditing that can track the finest changes to a
model. A Project Transfer function helps you to make backups of models without involving information technology
personnel. There are also Model Validation and Project Integrity Checkers to ensure the repository is maintained with a
clean bill of health, and a powerful role based Security System to ensure users can collaborate easily.

Facilities
Facility Detail

Version Control of Enterprise Architect Model Version Control helps you to:

Packages e Coordinate sharing of Packages between users, with either read-only access or
update access, ensuring that work on different areas of the model is
coordinated and synchronous rather than conflicting

e Save and retrieve a history of changes to Packages
To use version control in Enterprise Architect, you require a third-party
source-code control application such as:
e Subversion
e CVS
e MS Team Foundation Server (TES), or
e Any other version control product that complies with the Microsoft Common
Source Code Control standard
Tracking Changes Enterprise Architect provides two separate but complementary facilities for
tracking changes to data across the project:
e Auditing of model changes
e Baselining and differencing to capture and roll back changes
Project Data Transfer Enterprise Architect enables you to transfer project data between project data

repositories either for:
e  Sections of the project (XMI and CSV) or

e  The whole project, row by row, table by table (in the Corporate, Business and
Software Engineering, Systems Engineering and Ultimate editions of
Enterprise Architect)
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Version Control

Within Enterprise Architect, you can manage changes to and revisions of your projects by placing individual model
Packages, view nodes or root nodes under version control. Version control provides numerous key facilities, including:

e Saving a history of changes to Packages

e The ability to retrieve previous revisions of Packages

e  Propagating model updates between team members

e Coordinating the sharing of Packages between team members

You apply version control through a third-party source-code control application that manages access to and stores
revisions of the controlled Packages. Once the version control software has been installed and configured, you must
define a Version Control Configuration within your project. You can then use version control to manage changes to the
Packages of your model.

Notes

e  Sparx Systems strongly urge you not to manipulate version controlled Package files outside of Enterprise Architect;
it is possible to leave the Package files in a state that Enterprise Architect cannot recognize

e Database replication should not be combined with version controlled Packages

e If the Packages under version control contain any alternative images and those images are subject to frequent
change, you can set the 'Export alternate images' option on the 'Preferences' dialog to export the images to the
version control repository when you check in the Packages; if the images are not subject to frequent change, do not
select this option and instead use "Export/Import Reference Data' to manage alternative images
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Introduction

Enterprise Architect's version control integration provides several key facilities, including:

e Saving a history of changes made to your model's Packages

e Retrieving previous revisions of Packages

e  Propagating model updates between team members

e Coordinating the sharing of Packages between team members

The steps involved in setting up a version control environment and applying version control to an Enterprise Architect
project that is to be accessed by a number of users, are summarized in the Help topic 'Applying Version Control in a

Team Environment'.

There are a number of factors to consider when setting up and using version control in your model development.

Factors to consider

Factor

System Requirements and
Configuration

Version Control Usage

Team Deployment

Version Control Basics

Applying Version Control

to Models

Version Control and
Project Reference Data

(c) Sparx Systems 2015 - 2017

Detail

You apply version control through a third-party source-code control application
that manages access to and stores revisions of the controlled Packages.

Typically the configuration consists of:
e A server component that manages a version control repository, and

e Client components on the workstations, that manage local working copies of
controlled files

Enterprise Architect uses the client component to communicate with the server. A
version control client must be installed on every machine where you run Enterprise
Architect and want to access your version control system.

There are two main ways in which projects can be deployed:
e (entralized Shared Model
e Distributed Private Models

Version control is employed in the same way for both scenarios; however, when
using Private Model deployment you have the additional facility of propagating
model updates throughout the team.

Version Control can also be used to share standard Packages between different
projects.

Consider the process of setting up a version control environment and applying
version control to a project to be accessed by a number of users.

Enterprise Architect enforces serialized editing of version controlled Packages,
using the lock-modify-unlock mode of operation.

Using version control consists of placing individual model Packages under version
control, rather than version controlling the project as a whole.

To share changes in reference data between users in a version-controlled project
deployed as multiple private models, you periodically export the reference data
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from the model where the changes were made, and import it into the other models
maintained by the team.

Offline Version Control You can prevent the system from attempting to make any version control
connections by choosing to Work Offline before loading a model.

If Enterprise Architect is unable to connect a Version Control Configuration for any
reason, it displays warning messages to notify you and provides 'offline' version
control functionality for all Packages associated with the failed connection.

Notes

e Packages under version control are identified in the Project Browser by icons that indicate the current status of the
Package
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Version Control Usage

The version control facility can be used in many different ways, although these roughly fall into one of four types of use

as discussed here.

Usage

Type

Single Shared model

Multiple Private models

Shared Packages

Standard Packages

(c) Sparx Systems 2015 - 2017

Details

Users share a model stored in a central project file or DBMS repository. In this
configuration you can view changes to other users' Packages without explicitly
having to check them out, by simply refreshing your view of the model.

Version control is used to:
e Archive successive versions of your work to date
e  Maintain Package revision history

e Recover from unwanted changes or accidental deletions, through an 'undo’
facility

e Regulate access to Packages

One model is created by a single user who configures it for version control. The
model file is then distributed to other users, with each user storing their own private
copy of the model.

Version control is used to:

e  Propagate changes to the model, throughout the team
e Archive successive versions of your work to date

e Maintain Package revision history

e Recover from unwanted changes or accidental deletions, through an 'undo’
facility

e Regulate access to Packages

Individual users create separate models but share one or more Packages:

e  Users share Packages through version control
A company might have a standard set of read-only Packages that are broadly

shared:

e Individual users retrieve Packages with the Get Package menu option
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Version Control of Model Data

When applying version control in Enterprise Architect, you place individual model Packages under version control, and
not the project as a whole.

All Enterprise Architect models are stored in databases - even the .eap file is an MS Jet database. In simple terms, the
project file is a single entity of binary data. Being binary data, the project file would require the use of the
lock-modify-unlock model of version control, which would mean that only a single user at a time could work on any
given (version controlled) model. Therefore, it is not practical to apply version control to the database (.eap file) as a
whole; this can also create problems for you:

e Most version control systems mark their controlled files as read only, unless they are specifically checked-out to you

e The .cap file is an MS Jet database, and Enterprise Architect must be able to open this file for read/write access
when you load your model; the system displays an error message and fails to load the model if it is read-only

Version Controlling Packages in your Model

To overcome these limitations, Enterprise Architect exports discrete units of the model - the Packages - as XMI Package
files, and it is these XMI files, not the project file, that are placed under version control. The XMI file format used by
Enterprise Architect dictates that they too be treated as binary files - therefore it is not possible to merge the XMI files
either; however, by splitting the model into much smaller parts, many users can work on separate parts of the model
simultaneously.

Version Controlled Nested Packages

Version controlled nested Packages result in much smaller XMI files being exported, as the parent Packages' XMI files
do not contain any content for the version controlled child Packages.

Version control of nested Packages, together with a model structure of small individual Packages, provides greater scope
for multiple users to work concurrently, as individual users are locking much smaller parts of the model.
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Version Control and Reference Data

Reference data is data that is used across a model or project; it is not Package-specific. Version control operates at
Package level, and therefore does not capture changes in reference data. Where version control is used in a multiple
private model set up, changes in reference data are not brought into the model when Packages are updated from version
control.

In a Shared Model environment, all users are accessing the same project reference data. Changes in reference data can be
shared between users in a version-controlled project deployed as multiple private models, by periodically exporting the
reference data from the model where the changes were made, and importing it into the other models maintained by the
team.

Reference data is exported and imported as an XMI file, which contains whatever types of reference data you want to
transfer. You can place your project reference data under version control by exporting the data as an XMI file and apply
version control to that file using your version control software external to Enterprise Architect.
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Version Control Basics

Enterprise Architect implements version control of your model by exporting Package data from the project database to
XMI Package files, which are placed under version control in the source-code control application. The XMI file format
cannot be merged in the same way as ordinary text files can be merged, which is why Enterprise Architect must enforce
serialized editing of version controlled Packages, as discussed here.

The Lock-Modify-Unlock Solution

Many version control systems use a lock-modify-unlock model to address the problem of different authors in a shared
source overwriting each other's work. In this model, the version control repository allows only one person to change a
file at a time, and access is managed using locks.

Harry must lock a file before he can begin making changes to it. If Harry has locked a file, Sally cannot also lock it, and
therefore cannot make any changes to that file. All she can do is read the file, and wait for Harry to finish his changes
and release the lock. After Harry unlocks the file, Sally can take her turn in locking and editing the file.

The Copy-Modify-Merge Solution

Subversion, CVS and a number of other version control systems use a copy-modify-merge model as an alternative to
locking. In this model, each user's client contacts the project repository and creates a personal working copy - a local
reflection of the repository's files and directories. Users then work simultaneously and independently, modifying their
private copies. In due course, the private copies are merged together into a new, final version. The version control system
often assists with the merging, but ultimately a person is responsible for making it happen correctly.

When Locking is Necessary

While the lock-modify-unlock model is generally considered a hindrance to collaboration, there are still times when
locking is necessary.

The copy-modify-merge model is based on the assumption that files are contextually merge-able: that is, that the files in
the repository are line-based text files (such as program source code). However, for files with binary formats, such as
artwork or sound, it is often impossible to merge conflicting changes. In these situations, it really is necessary for users to
take strict turns in changing the file. Without serialized access, some users end up wasting time on changes that are
ultimately overwritten.
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Applying Version Control in a Team Environment

The process of setting up a version control environment and applying version control to a project to be accessed by a
number of users is summarized here.

Version Control - Process Overview

Step Action

1 Install your version control product.

2 Create a version control repository.

3 Create a version control project to be used with your Enterprise Architect project.

4 Check-out a working copy of the version control project (a module, project or folder within the version

control system) into a local folder.

You must do this for every team member that is accessing the version controlled Packages, whether you
are using a single shared model or each team member stores his own private copy of the model.

5 Before attempting to access the new version control environment from within Enterprise Architect, you
should first verify that it functions correctly when used outside of Enterprise Architect.

6 Within Enterprise Architect, define a version control configuration to provide access to the working copy
files.

The name of the version control configuration must be the same across all machines throughout a team.
That is, all version control access to a given Package must be through version control configurations with
the same name, across all models and all users.

The easiest way to perform this step, (throughout the team), is to have one user set up version control on
the model and then share that model with the rest of the team.

e In Shared Model deployment, all users connect to a single instance of the model database, so the
model is shared automatically

e In Private Model deployment, it is easiest to distribute copies of the original model (after version
control has been set up) to all other members of the team

Whenever you open a model (Private or Shared) that uses a version control configuration that is not yet
defined on your workstation, a prompt displays to complete the definition for that configuration. This
typically means specifying the local working copy directory and perhaps choosing the version control
project associated with this Enterprise Architect project.

Once this has been done, the version controlled Packages that already exist in the model are ready for use.

7 Configure Packages within the Enterprise Architect model for version control. That is, apply version
control to individual Packages.

8 Check-out and check-in Packages as required.

Notes
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e [tis possible to use multiple version control configurations within the same model; different Packages can still use
different version control configurations within the model, as long as any given Package is always accessed via the
same version control configuration
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Version Control Nested Packages

When you save a Package to the version control system, only stub information is exported for any nested Packages. This
protects information in a nested Package from being inadvertently over-written by a top level Package.

Operations on Nested Packages

Operation Detail

Checking Out When you check out a Package, you do not modify or delete nested Packages; only
the top level Package is modified.

As a consequence of this behavior, if you check out or get a version controlled
Package with nested Packages that are not already in your model, you see stubs in
the model for the nested Packages only.

Get All Latest If you select the 'Get All Latest' option from the version control menu, any new
stubs are populated from the version control system.

Importing Models You can populate a large and complex model, by 'getting' only the root Packages,
then using 'Get All Latest' to recursively iterate through the attached and nested
Packages.

This is a powerful and efficient means of managing your project and simplifies
handling very large models, even in a distributed environment.

The Tmport a Model Branch' option combines the procedure steps into a single
operation.

Notes

e Itis recommended that, when sharing a version controlled model, you do not mix versions of Enterprise Architect
later than version 4.5 with earlier versions; if this is necessary it is best to go to the 'Version Control Settings' dialog
and deselect the 'Save nested version controlled packages to stubs only' checkbox, setting Enterprise Architect to the
pre-version 4.5 behavior (for the current model only)

(c) Sparx Systems 2015 - 2017 Page 14 of 121 Created with Enterprise Architect



User Guide - Change Management 30 June, 2017

Add Connectors To Locked Elements

Generally, when working in a diagram containing locked elements, you cannot add a connector to a locked element.
However, this depends on the lock status of the source and target elements (or more precisely, the lock status of the
parent Packages of the source and target elements, when the source and target element are held in different Packages).
There are scenarios in which a connector can be created on a locked element.

Lock Scenarios

Element Status Add Connectors

Source unlocked, target Yes, any kind of connector can be added
unlocked
Source unlocked, target Yes, except for Composition connectors
locked
Source locked, target No, except for Composition connectors
unlocked
Source locked, target No, prohibited for all connectors
locked

Notes

e A connector can be added if its source is unlocked - you are modifying what the source can see

e The exception is Composition connectors, where the target (the parent) must be unlocked - you are modifying the
parent by adding children
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Project Browser Indicators

Packages under version control are identified in the Project Browser by icons that indicate the current status of the
Package.

Indicators

Icon Indicates that

=] This Package is version controlled and not checked out to you.

You cannot edit the Package (until you check out the Package yourself).

o This Package is version controlled and checked out to you.

You can edit the Package.

i This Package is version controlled, but you checked it out whilst not connected to
the version control server.

You can edit the Package but there could be version conflicts when you check the
Package in again.

i1 This Package is controlled and is represented by an XMI file on disk, but it is not

under version control.

You can edit this Package.
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Offline Version Control

When loading a model that uses version control, Enterprise Architect normally initializes a connection to the version
control system for each version control configuration defined in the model. If Enterprise Architect is unable to connect a
version control configuration for any reason, it displays warning messages to notify you and provides offline version
control functionality for all Packages associated with the failed connection.

You can prevent Enterprise Architect from starting to make any version control connections, by selecting to work offline
menu before loading your model.

Access

Ribbon Configure > Version Control > Work Offline

Working Offline

Concept Discussion

Choosing to Work Offline Selecting to work offline is useful if you know beforehand that Enterprise Architect
cannot connect to your version control system. For example: If you are working on
a laptop computer that is disconnected from your network, on an Enterprise
Architect model that uses a large number of version control configurations, you can
select to work offline before you load the model to avoid all the error messages that
the system would normally display as each version control connection attempt
failed.

You can switch between working offline and working online at any time, either
before or after a model is loaded, by toggling the 'Work Offline' menu option.
Enterprise Architect disconnects or reconnects version control (depending on the
connection availability) according to your selection.

Using Version Control Enterprise Architect 'remembers' the status of a model’s version controlled

Whilst Disconnected From Packages. Packages that were checked out to you prior to disconnecting from the

the Version Control Server server are still shown as checked out to you, even though you are no longer
connected to the server. You can still edit these Packages as you normally would.

Packages that were not checked out to you prior to disconnecting from the server
are shown as version controlled and locked. You cannot edit these Packages until
you check them out.

Offline Check Out You can 'check-out' and edit a version controlled Package even when your machine
is disconnected from the version control server. In this example, the colored 'figure
8'icon for DFD indicates that you have checked it out whilst off line.

+ =] MindMapping
+-§5| DFD
+ 43| Logical View

(The gray 'figure 8' icon shown against Logical View indicates that you have
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checked out a version-controlled Package on line.)

You should be aware that the version control system, and therefore other users,
have no way of knowing that you have 'checked-out' a Package whilst offline. It is
not possible to merge changes to an XMI file that result from two users editing the
same Package at the same time. If an offline checkout leads to two people editing
the same Package at the same time, when the changes are brought back online the
first-saved set of changes is lost.

Checking In a Package Once you reconnect your system to the version control server, if the Package you
That Was Checked Out checked out offline is not currently checked out by another user, you can check in
Offline that Package. However, before Enterprise Architect checks in the Package, it

compares the local working copy of the Package file with the latest revision in the
repository. (These Package files remain unchanged in your work area until
Enterprise Architect exports the Package again before checking in.) If the
repository version remains unchanged from when you last updated your local copy,
Enterprise Architect exports and checks in your Package without further prompting.

On the other hand, if the repository now contains a file that has changed since you
last updated your local copy, checking in your Package would overwrite those
changes. Enterprise Architect displays a message warning you of the pending data
loss and giving you the opportunity to abort the check in. At this point, you must
decide whether to discard your own changes, using the Undo Check Out command,
or continue with your check in and overwrite the changes that have been committed
to the repository since you last updated your local copy from the repository.

You can use the File Properties command to determine who checked in the last
changes to this Package. This might help you to discover what changes have been
uploaded and decide whose changes take precedence.

Update Before You Whenever you are connected to the version control server, you are always working

Disconnect with the latest version of a Package. This is because you cannot modify a Package
until you check it out from version control, and checking it out loads the latest
revision from the repository into your model.

This cannot happen when you are disconnected from the version control server.
You are working on whatever versions you have on your machine, dating back to
the last time you updated your local copy of each version controlled Package. So, if
you are planning to work on a model whilst disconnected from version control, it is
a very good idea to make sure that you have the latest versions of all Packages
before you disconnect. The 'Get All Latest' option makes this a simple task.
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Version Control Branching

Currently, Enterprise Architect does not support Version Control Branching.

Work-arounds to achieve similar results might be possible for certain version-control products; contact Sparx Support for
advice.

Contacts
User Type Contact via
Registered users http://www.sparxsystems.com/registered/reg_support.html
Trial users support@sparxsystems.com
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Version Control Product Setup

To control and maintain the different revisions of your project Packages, Enterprise Architect uses third-party version
control products. Once your version control product is installed and a suitable environment has been created, Enterprise
Architect can use that environment to control your project's Packages.

Typically, version control products consist of:
e A server component
e A client component

Enterprise Architect integrates with the version control client components for Subversion, CVS and MS Team
Foundation Server command line clients, as well as for products having API clients that comply with the MS SCCI
specification.

Version Control System Components

Component Detail

Version Control Server The server component maintains the controlled files in their many revisions, in a
central repository.

The server component is usually located on a server machine that is accessible to all
team members who are using version control.

Server Configuration The steps for configuring a version control server are, broadly:
e Install the software
e (Create a repository

e C(Create version control projects (or modules or folders for use with specific
projects)

e  Configure user IDs and passwords

For details on configuring any particular version control server, consult the
appropriate documentation provided with the version control product.

Version Control Client The client component manages the working copies of the controlled files,
submitting files to or retrieving files from the server as required.

A version control client must be installed on every machine on which you run
Enterprise Architect and want to access your version control system.

Client Configuration The steps for configuring a version control client are, broadly:
e Install the software
e (Create a new directory for use as a local working copy folder
e Login to the version control server

e  Associate the working copy folder with its corresponding server repository
folder

For details on setting up a product-specific version control environment for use
with Enterprise Architect, click on the appropriate link in the next column.
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System Requirements

Enterprise Architect is a Windows-based application and requires a Windows-based version control client for integration.
It is independent of the version control server component and the platform on which that runs.

Version Control Product Requirements

Product Detail

Subversion Subversion is free, open source software.

Subversion server components are available to run on a wide range of different
hardware and operating systems.

Enterprise Architect is not affected by your choice of server components, but
requires Subversion's Windows-based command line client for integration.

There are many graphical user interface clients available for use with Subversion,
such as TortoiseSVN; this type of client cannot be used directly for integration with
Enterprise Architect, but can be very useful in preparing a working Subversion
environment for use by Enterprise Architect.

Binary Packages are available for download from:

e  http://subversion.apache.org/packages.html

Subversion documentation is available from:

e  http://svnbook.red-bean.com/nightly/en/index.html

Concurrent Versions CVS is free, open source software.

System (CV8) CVS server components are available to run on a wide range of different hardware

and operating systems.

Enterprise Architect is not affected by your choice of server components, but
requires CVS's Windows-based command line client for integration.

There are many graphical user interface clients available for use with CVS, such as
TortoiseCVS; this type of client cannot be used directly for integration with
Enterprise Architect, but can be very useful in preparing a working CVS
environment for use by Enterprise Architect.

The software is available for download from:

e  http://www.nongnu.org/cvs/

CVS documentation is available from:
e  http://cvsbook.red-bean.com/cvsbook.html

Microsoft Team Enterprise Architect is able to use either the:
Foundation Server e Command line client for TFS, or

e  MS TFS-SCC client

Your choice of client affects how you specify your Version Control Configuration.
MS TFS-SCC clients are available for download from Microsoft's web pages:

e Visual Studio 2005 Team Foundation Server MSSCCI Provider

e Visual Studio Team System 2008 Team Foundation Server MSSCCI Provider
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Any version control product that provides a client that complies with the Microsoft
Common Source Code Control standard, version 1.1 or higher, can be integrated
with Enterprise Architect.

These products are SCC-compatible and are known to successfully integrate with

Enterprise Architect:

e Accurev

e (ClearCase

e MS Visual Source Safe
e MS TFS-SCC

e  MKS Source Integrity
e Perforce

e  Source Offsite

e Snapshot CM

Products that do not appear in this list should still integrate successfully with
Enterprise Architect, if there is a client available for that product that complies with
the MS SCC API specification.
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Create a Subversion Environment

You can use Subversion as a version control provider for Enterprise Architect. The first step in doing this is for a
Subversion administrator to install and configure the appropriate software. A number of basic tasks are performed in
creating an operational Subversion environment, and useful tools are available for performing some of these tasks.

Tasks in Creating a Subversion Environment

Task Detail
Install server components Executable files for Subversion can be obtained from the Apache Software
Foundation.

Subversion server components are available to run on a wide range of different
hardware and operating systems; Enterprise Architect is not affected by your choice
of server components.

VisualSVN is a package that can greatly simplify the installation, configuration and
management of your Subversion server.

Create a repository Please consult the official Subversion documentation.

Create Subversion users Please consult the official Subversion documentation.

Create a new repository It is good practice to create a new repository sub-tree in Subversion for each new

sub-tree Enterprise Architect model being added to version control with Subversion. Users
should create a new local working copy from the sub-tree to be used with that
model

TortoiseSVN can greatly simplify the process of creating new repository sub-trees.

Install client components Executable files for Subversion can be obtained from the Apache Software
Foundation.

Create a working copy A working copy folder must exist on each users' machine, for Enterprise Architect

folder to use when exporting and importing the version controlled Package files. It is this

folder that is specified as the Local Project Path, when defining your Version
Control Configurations.

The working copy folder is the 'sandbox' where you modify the controlled files. The
working copy folder is usually associated with a folder that exists within the
version control repository. In Subversion, to create a local working copy you
perform an initial check-out of a folder from the Subversion repository; this
downloads a copy of the folder and its contents, to create your local working copy.

TortoiseSVN can greatly simplify the initial check out of a working copy folder.

Setting up Subversion The process of setting up and using Subversion with Enterprise Architect under

under Wine/CrossOver Wine is almost identical to the process when running natively under Windows,
apart from minor differences in installing the Subversion client and performing the
initial check out of the working copy folder.

Notes
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e  Enterprise Architect relies on exclusive file locking when applying version control to its Packages; file locking was
not introduced into Subversion until version 1.2, therefore Enterprise Architect does not work with Subversion
releases earlier than Subversion 1.2

e  Enterprise Architect can only communicate with the Subversion server using the Subversion command line client
svn.exe
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Create a new Repository Sub-tree

When you set up Subversion as your version control tool, it is good practice to create a new repository sub-tree in
Subversion for each new Enterprise Architect model. The sub-tree can be used to control the Package files for your
model.

Create a new sub-tree in the Subversion Repository

Step Action

1 Use Windows Explorer to create a temporary directory on your PC file system, to be imported into the
Subversion repository as a new repository sub-tree. The directory would have this structure:

2 Open a Windows command prompt, navigate to tempDir and issue the Subversion command import.
For example:
C:\Documents and Settings\user> cd \tempDir
C:\tempDir> svn import . https://host.example.com:8443/repos/

--message "Repository Initialization"

3 On your PC, delete the temporary directory structure (tempDir) and all its contents.

Notes

e  After the import is finished, the original tree is not converted into a Subversion working copy; you should delete the
temporary structure and check out a fresh working copy of the tree

e  The process can also be performed using TortoiseSVN's Repository Browser, which provides commands for simply
creating new folders directly in the repository
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Create a Local Working Copy

In order to use Subversion to provide version control of the Packages in a model, you need to prepare a functional SVN
working copy folder that can be accessed through an Enterprise Architect version control configuration within that
model.

Create a Subversion working copy folder

Step Action

1 Choose or create a suitable directory on your system in which to create your Subversion working copy.

2 Open a command prompt window and navigate to the directory you have selected. For example:
C:\> mkdir mySVNWorkSpace
C:\> mkdir mySVNWorkSpace/myEAModelName
C:\> cd mySVNWorkSpace/myEAModelName

3 Perform the initial check out from the Subversion repository, specifying the repository folder and local
working copy folder, as well as your user name and password. For example:

C:\> svn checkout "https://myserver:8443/svn/repos_folder
"C:\mySVNWorkSpace/myEAModelName"

--username myUserName

--password myPassword

(By specifying your Subversion username and password, you ensure that they are correctly cached by
Subversion and available for use by Enterprise Architect.)

If you specify the HTTPS protocol when performing the initial Subversion check out, a prompt displays to
accept a security certificate; in this instance, press the P key to permanently accept the certificate.

The nominated local folder is configured as a Subversion working copy folder.

Any files already existing in the repository folder are downloaded to the working copy folder as working
copy files.

4 Verify that your Subversion environment functions correctly.

Notes

e [tis important that Subversion caches your username and password, so that it never has to prompt for user input; a
check-out operation might not request authentication, and if it does not you should perform an action that does
request authentication, such as adding and committing a dummy test file

e  The process can also be performed using TortoiseSVN's Checkout command (which provides options to browse
when specifying both your repository folder and your local folder); when prompted for authentication details by
TortoiseSVN, make sure you place a check against the 'Save Authentication Data' option
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Verify the SVN Workspace

After creating the Subversion local working copy to hold the working copies of your Package files, you can verify that it
functions correctly before attempting to use it with Enterprise Architect. You need to be able to add files to Subversion,
lock the files and commit changes to those files.

Verify correct operation of a Subversion working copy folder

Step Action

1 Use Windows to open a command prompt window.
2 Select the directory you specified as the working copy, in the Subversion checkout command when
preparing the SVN workspace. For example:
C:\> cd mySVNWorkSpace
3 Create a test file, such as Test.txt, containing the text Subversion Test. For example:

C:\> echo Subversion Test > Test.txt

4 Execute each of these Subversion commands:

svn add Test.txt

svn commit -m"Commit comment" Test.txt

svn update Test.txt

svn lock Test.txt

Use your preferred editor to modify the file and save the changes

svn commit -m"Second commit comment" Test.txt

The commands should execute without any errors and without prompting the user for any extra input.

Notes

e  Your environment must be set up such that you can perform these operations without ever being prompted for user
ID or password; for further information, please see the Caching Client Credentials topic in the official Subversion
documentation
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Subversion Under Wine-Crossover

If you want to set up and use Subversion with Enterprise Architect under Wine, the process is almost identical to the
process for setting up and using the systems under Windows. When running Enterprise Architect under Wine or
CrossOver, you still use a Windows-based Subversion command line client.

There are some minor differences in the way you prepare the Subversion working environment, specifically in the way
you install your Subversion client and the way you check out a working copy folder from the Subversion repository.

System Requirements

Sparx Systems has tested the use of Enterprise Architect with Subversion under Wine 1.2, on macOS 10.4 and 10.6.2,
and on Ubuntu 10.04. All tests were passed.

When using Wine 1.2 on the Ubuntu 9.10 platform, Sparx Systems was able to use the svn: and file: protocols to
communicate with the SVN server; but not the https: protocol.

Installing a Subversion Client

Wine is able to install applications from either a Windows .exe file, or a .msi installer file.

Place the installer for your Windows Subversion client in a convenient location on the native file system, then open a
Wine console window from within Enterprise Architect and run the installer from within the Wine console. Your
Subversion installation can then access the same C: drive and folders that Enterprise Architect is accessing.
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Preparing a Subversion Environment Under Wine

Under Wine, you can install Subversion from either a Windows .exe file, or a .msi file. By performing your Subversion
installation and initial check out from a Wine console window opened from within Enterprise Architect, you have access
to the same C: drive and folders that Enterprise Architect is accessing.

Set up Subversion for use with Enterprise Architect, running under Wine

Step Action

1 Start Enterprise Architect.

You do not have to load a project at this point.

2 From the Start ribbon, select 'Workspace > Preferences > Customize > Tools: e |'
A new, blank entry is opened on the 'Tools' tab of the 'Customize' dialog.
3 Define the new menu item entry:
e In the newly-opened 'Menu contents' field, type the name 'Wine Console'
e In the 'Command' field, type 'wineconsole'
e Inthe 'Arguments' field, type 'cmd'
e [eave the 'Initial directory’ field blank
4 Click on the Close button.
The 'Customize' dialog closes.
5 From the Configure ribbon, select 'User Tools > Wine Console'.
A Wine console window opens.
6 Type 'C:' and press the Enter key.
The Wine console switches to the C: drive.
7 Issue the command to install your Subversion client. For example:
C:\>/Installers/Subversion-client-1.6.12-1.win32.exe
To install from a .msi file, use Wine's msiexec utility. For example:
C:\>msiexec /i "Slik-Subversion-1.6.9-win32.msi"
Installation of the Subversion command line client begins.
8 Create a folder to serve as the working copy folder to be used by Enterprise Architect. For example:
C:\>mkdir C:\VC_workspaces\SVN_workcopy
9 Issue the command to perform the initial checkout from the Subversion repository, specifying the

repository folder, working copy folder, username and password. For example:
C:\>svn checkout "https://myServer:8443/svn/repos_folder"
"C:\VC_workspaces\SVN_workcopy "
--username myUserName

--password myPassword
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(After specifying your Subversion username and password, they are correctly cached by Subversion and
are available for use by Enterprise Architect.)

If the HTTPS protocol is specified when performing the initial Subversion check out, you are prompted to
accept a security certificate; in this instance, press the P key to permanently accept the certificate.

The nominated local folder is configured as a Subversion working copy folder. Any files already existing
in the repository folder are downloaded to the working copy folder as working copy files.

10 Type 'Exit' and press the Enter key.
The Wine console window closes.

You are now ready to load a project in Enterprise Architect and apply version control to it, using the
normal Windows-based procedures.

Notes

e You should copy the installer for your Windows Subversion client to a convenient location on the native file system,
so that you can easily refer to it from within the Wine console window in step 7
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TortoiseSVN

TortoiseSVN is a Windows shell extension for Subversion; it provides icon overlays in Windows Explorer that are useful
as a tool for observing the status of your Subversion controlled files. You can also use it to create your repository
sub-trees and check out local working copies from within Windows Explorer, using simple menu commands.

You can download TortoiseSVN from http://tortoisesvn.net/downloads.html.

Notes

e  Enterprise Architect can only communicate with the Subversion server using the Subversion command line client
svn.exe
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Create a TFS Environment

You can use Microsoft Team Foundation Server (TFS) as a version control provider for Enterprise Architect. The first
step in doing this is for a TFS administrator to install and configure the TFS server and client applications. A number of
basic tasks are performed in creating an operational TFS environment.

Tasks in Creating a TFS Environment

Task Detail
Obtain and install TFS Enterprise Architect uses the TFS command line client to integrate TFS version
control.

The TFS command line client is normally available as part of your Visual Studio
installation.

Choose a TFS project It is good practice to create a new TFS project, or least a new Source Control
Folder within a project, for each Enterprise Architect project being added to version
control with TFS.

If you have a single Enterprise Architect project that contains many different
models (for example, a DBMS hosted project with multiple model root nodes), you
might choose to create a new TFS project for each separate model.

For further information, please consult your TFS product documentation.

Create a TFS workspace A working copy folder must exist on each users' machine, for Enterprise Architect
to use when exporting and importing the version controlled Package files. It is this
folder that is specified as the Local Project Path, when defining your Version
Control Configurations.

The working copy folder is the 'sandbox' where you modify the controlled files. The
working copy folder is usually associated with a folder that exists within the
version control repository. In TFS, the TFS workspace is used to map a local
working folder on your PC to a Source Control Folder within a TFS project.

TFS 2012 and VS 2012 (and later versions) feature a new type of workspace called
'local' workspaces. Do not attempt to use TFS 'local' workspaces with Enterprise
Architect. You must use only 'server' workspaces for Enterprise Architect version
control, as 'local' workspaces do not support the application of checkout locks to
files. Enterprise Architect relies on the presence of checkout locks to ensure that
Packages can only be checked out exclusively and that a given Package is not
already checked-out in some other project (for instance, in a Private Model
deployment). This is necessary because it is not practical to merge the XMI
Package files that Enterprise Architect uses for version control.

A single TFS workspace can map many different local folders, each one to a
separate Source Control Folder. In this case, TFS can take a long time to work
through and update the files in all of those folders, and the system might appear to
'freeze' whilst it waits for TFS to hand back program control.

You can avoid this if you keep your version controlled Package files in a folder that
is separate from other artifacts, such as source code files, creating a separate work
space to use just for your Package files, or creating and mapping a separate folder
for Package files within an existing workspace.

Configure exclusive The XMI format files used for the version control of Enterprise Architect's
check-outs Packages can not be merged like ordinary text files. Therefore, Enterprise Architect
must enforce serialized editing of its version controlled Packages. As a
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consequence, it is important that TFS is configured to use 'exclusive checkouts' for
XML files.

Verify the TFS Workspace Enterprise Architect uses the TFS command line client to checkin and checkout
files from the TFS repository. After creating the TFS workspace, it is important to
verify that the command line client can be used to add, check-in and check-out files
residing in the working copy folder that is mapped through this workspace.

Notes

e TFS can also be used with an SCC client; the MS TFS-SCC client is available for download from Microsoft's web
site

e  MDG Integration for Visual Studio 2005 or 2008 enhances TFS support by providing access to, for example, work
items and bugs within both Enterprise Architect and the MDG Integration product
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TFS Workspaces

In order to use TFS to provide version control of the Packages in a model, you prepare a functional TFS workspace that
can be accessed through an Enterprise Architect version control configuration within that model. You use the TFS
workspace to map a local working folder on your PC to a Source Control Folder within a TFS project repository.

It is assumed that have TFS 2013 open and a TFS Team Project already exists for you to use in version controlling the
Packages of your Enterprise Architect project. You can create the TFS workspace through MS Visual Studio.

TFS 2013 and later versions support the use of Local workspaces. However, Local workspaces do not support the
application of checkout locks. For this reason, Sparx Systems strongly advises against the use of Local workspaces when
version controlling your Enterprise Architect Package files. Using Local workspaces carries a high risk of merge
conflicts when checking in, which would almost certainly result in loss of data or a corrupted model database.

Map a local folder to a TFS Source Control Folder

Step Action

1 Connect to your TFS server.
From the TFS main menu, choose 'View | Team Explorer'.

In the Team Explorer toolbar, click on the Connect to Team Projects button (fourth from left, with a
power plug icon).

The 'Team Explorer Connect' page displays.

2 Click on the link 'Select Team Projects...'

The 'Connect to Team Foundation Server' dialog displays.

3 Click on the appropriate Team Foundation Server, Team Project Collection and Team Project, then click
on the Connect button.

4 Click on the Home page of the Team Explorer, and then on the Source Control Explorer button.

The Source Control Explorer view displays.
5 In the Source Control Explorer, click on the drop-down arrow in the '"Workspace' field in the toolbar, then
click on 'Workspaces' at the bottom of the list.

The "Manage Workspaces' dialog displays.

6 Click on the Add button.
The 'Add Workspace' dialog displays.

7 Click on the Advanced button.
A number of new fields display on the dialog.

8 Type in an appropriate name for the new workspace and, if required, type in a comment.

9 Set the 'Location' field to 'Server'. This setting is important.

This setting is not available in TFS 2010 and earlier releases, where all workspaces are Server based.
10 Click in the Source Control Folder column, then click on the Browse button to select a Source Control

Folder.

Select the Source Control folder (in the Team Project) to use for controlling Enterprise Architect
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Packages.

11 Click on the Browse button in the Local Folder column and create a new local folder.

This is the working copy folder into which Enterprise Architect exports the Package files.

12 Click on the OK button.
The new workspace is created and saved.
The 'Add Workspace' dialog closes.

13 Click on the OK button.
The '"Manage Workspaces' dialog closes.

Notes

e  The local folder referenced in step 11 is the Working Copy Path that should be specified when defining an
Enterprise Architect Version Control Configuration to use this TFS workspace
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TFS Exclusive Check Outs

The XMI format files used for the version control of Enterprise Architect's Packages can not be merged as ordinary text
files can. Therefore Enterprise Architect must enforce serialized editing of its version controlled Packages, and it is
important that Team Foundation Server is configured to use 'exclusive checkouts' for XML files. Otherwise, TFS can
return file statuses that make it look as if the Package file is not checked-out by another user when indeed it is.

You set exclusive checkouts in the TFS workspace through MS Visual Studio.

Configure TFS to enforce exclusive check outs for XML files

Step Action

1 Using Visual Studio, from the main menu select 'View | Team Explorer'.

2 In the 'Team Explorer' pane, right-click on the TFS Server name that is controlling the Enterprise
Architect Package files, then from the context menu select 'Team Foundation Server Settings | Source
Control File Types'.

3 Select the entry for XML files (or create an entry if necessary) then click on the Edit button.

4 Deselect the 'Enable file merging and multiple check out' checkbox.
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Verify the TFS Workspace

Enterprise Architect will be using the TFS command line client to commit file updates from the local working copy
folder into the TFS repository. After creating the TFS workspace that maps your local working copy folder to a TFS
repository folder, it is good practice to verify that the TFS workspace functions correctly before attempting to use it with
Enterprise Architect. You need to be able to add files to TFS, place a check-out lock on the files and check-in changes to
those files.

Verify correct operation of a TFS Workspace

Step Action

1

Use Windows to open a command prompt window.

2 Select the directory you specified as the local working copy folder when creating the TFS workspace.
For example:
C:\> cd myTFSWorkingCopyFolder
3 Create a test file, such as Test.xml, containing the text "my TFS Test". For example:
C:\> echo my TFS Test > Test.xml
(The filename extension ".xml" is used because the TFS server should have been configured to allow
exclusive checkouts for XML files.)
4 Using the command line client, execute each of these TFS commands:
e tfiexe add Test.xml
e tfexe checkin Test.xml /override:"Manual check in." /comment:"a message"
e tf.exe checkout /lock:checkout Test.xml
Use your preferred editor to modify the file and save the changes.
e tfiexe checkin Test.xml /override:"Manual check in." /comment:"a message"
e tfiexe get. /recursive
Notes

All of the commands in step 4 should execute without any errors; in particular, you should be able to apply a
checkout lock when checking out the file

If the checkout command reports any errors, you might have to reconfigure the TFS workspace as a server based
workspace, or you might have to configure the TFS Server to use 'exclusive checkouts' for XML files
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Create a CVS Environment

You can use Concurrent Versions System (CVS) as a version control provider for Enterprise Architect. The first step in
doing this is for a CVS administrator to install and configure the appropriate software. A number of basic tasks are
performed in creating an operational CVS environment, and useful tools are available for performing some of these
tasks.

Tasks in Creating a CVS Environment

Task Detail

Install server components Executable files for CVS can be obtained from March Hare Software.

CVS server components are available to run on a wide range of different hardware
and operating systems; Enterprise Architect is not affected by your choice of server

components.

Create a repository Please consult the official CVS documentation.

Create CVS users Please consult the official CVS documentation.

Create a new repository It is recommended good practice to create a new repository module in CVS for each

module new Enterprise Architect model being added to version control with CVS. Users
should create a new local working copy folder from the module to be used with that
model.

A repository module represents a project, or a set of related files in the repository.

TortoiseCVS can greatly simplify the process of creating new repository sub-trees.

Install client components Executable files for CVS can be obtained from March Hare Software.

Enterprise Architect is a Windows based application - it requires a Windows based
CVS command line client for integration.

Create a working copy A working copy folder must exist on each users' machine, for Enterprise Architect

folder to use when exporting and importing the version controlled Package files. It is this
folder that is specified as the Local Project Path, when defining your Version
Control Configurations.

The working copy folder is the 'sandbox' where you modify the controlled files. The
working copy folder is usually associated with a folder that exists within the
version control repository. In CVS, to create a local working copy you perform an
initial check-out of a folder from the CVS repository; this downloads a copy of the
folder and its contents, to create your local working copy.

TortoiseCVS can greatly simplify the initial check out of a working copy folder.

Setting up CV'S under The process of setting up and using CVS with Enterprise Architect under Wine is
Wine/CrossOver almost identical to the process when running natively under Windows, apart from
minor differences in installing the CVS client and performing the initial checkout of
the working copy folder.
Notes
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e Ifyou do not already use CVS for version control, you should consider using Subversion instead; Subversion's
client-server protocols provide a broader range of possibilities for connecting to remote servers, with easier set up of
secure connections

e TortoiseCVS is a Windows shell extension; Enterprise Architect cannot use TortoiseCVS as its client, it must use
the CVS command line client
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Prepare a CVS Local Workspace

In order to use CVS to provide version control of the Packages in a model, you need to prepare a functional CVS
working copy folder that can be accessed through an Enterprise Architect version control configuration within that
model.

Prepare a CVS Working Copy Folder

Step Action

1 Ask your System Administrator to install CVS and create a remote repository, with a module that you can
use to control your Enterprise Architect Package files.

Your administrator must create a username and password for you before you can make a connection.

2 Select or create a suitable directory to use as your CVS working copy directory.

3 Open a command prompt window and navigate to your CVS working copy directory. For example:
C:\> mkdir myCVSWorkSpace
C:\> c¢d myCVSWorkSpace

4 Log in to the remote CVS repository. For example:

C:\myCVSWorkSpace> cvs -d:pserver:myUserID@ServerName:/reposPath login

Replace myUserID with your CVS username, replace ServerName with the name of your CVS server and
replace reposPath with the path to the repository on the server.

A prompt for a password displays.

5 Enter your password.

You are logged in to the CVS server.

6 Perform the initial checkout of the CVS repository module, into the local working copy directory. For
example:

C:\myCVSWorkSpace> cvs -d:pserver:myUserID@ServerName:/reposPath checkout moduleName
(Replace moduleName with the name of the repository module that you want to check out.)

A subdirectory is created in your current working directory, with the same name as the module being
checked out.

Any files already existing in the repository module are downloaded to the working copy folder as working
copy files.

7 Verify that your CVS environment functions correctly.

Notes

e Much of the process can also be performed (more simply) using the TortoiseCVS command 'Make New Module'
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Verify the CVS Workspace

After creating the CVS local working copy to hold the working copies of your Package files, you can verify that it
functions correctly before attempting to use it with Enterprise Architect. You need to be able to add files to CVS, and

commit changes to those files. You also need to be able to register as an editor of the file and retrieve the list of currently

registered editors.

Verify correct operation of a CVS working copy folder

Step

1

Notes
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Action

Use Windows to open a command prompt window.

Select the directory you specified as the working copy in the cvs checkout command, when preparing the
CVS workspace. For example:

C:\> ¢d myCVSWorkSpace

Create a test file, such as Test.txt, containing the text CVS Test. For example:
C:\> echo CVS Test > Test.txt

Execute these CVS commands:

e cvsadd Test.txt

e cvs commit -m"Commit comment" Test.txt

e cvs update Test.txt

e cvsedit Test.txt

e cvs editors Test.txt

The commands should execute without any errors and without prompting the user for any extra input.

The editors command should produce output that resembles this:
Testl.txt myUserID Tue Aug 9 10:08:43 2009 GMT myComputer
C:\myCVSWorkSpace\moduleName

Take note of the userID that follows the filename.

Enterprise Architect must find and use this user ID when you create your version control configuration.

Your environment must be set up such that you can perform these operations without ever being prompted for input,
such as user ID or password
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TortoiseCVS

TortoiseCVS is a Windows shell extension for CVS; it provides icon overlays in Windows Explorer that are useful as a
tool for observing the status of your CVS controlled files. You can also use it to create your repository modules and
check out local working copies from within Windows Explorer using simple menu commands.

You can download TortoiseCVS from: http://www.tortoisecvs.org.

Notes

e  Enterprise Architect must use the CVS command line client to communicate with the CVS server; it cannot use
TortoiseCVS
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Create an SCC Environment

You can use a Microsoft Common Source Code Control (SCC) compatible product as a version control provider for
Enterprise Architect. The first step in doing this is for an administrator to install and configure the server and client
applications. A number of basic tasks are performed in creating an operational SCC-based environment.

Tasks in Creating an SCC Environment

Task Detail
Install and configure your A version control server component is typically installed on a dedicated server
chosen version control machine. All Enterprise Architect users who require access to version control must
product be able to connect to the server machine.

After installing the version control software, the administrator should also create
version control user IDs for all users who require access to version control.

For further information, consult the product documentation for your particular
version control product.

Create a new SCC project It is good practice to create a new SCC version control project, or least a new folder
within a project, for each Enterprise Architect project being added to version
control with SCC.

If you have a single Enterprise Architect project that contains many different
models (for example, a DBMS hosted project with multiple model root nodes), you
might choose to create a new SCC version control project for each separate model.

For further information, consult the product documentation for your particular
version control product.

Configure your SCC The XMI-format files used for the version control of Enterprise Architect Packages
project to support exclusive can not be merged in the same way as ordinary text files can. Therefore, Enterprise
check-outs for XML files Architect must enforce serialized editing of its version controlled Packages. As a

consequence, it is important that your version control application is configured to
use 'exclusive checkouts' for XML files.

Create a local working A working copy folder must exist on each users' machine, for Enterprise Architect

copy folder to use when exporting and importing the version controlled Package files. It is this
folder that is specified as the Local Project Path, when defining your Version
Control Configurations.

The working copy folder is the 'sandbox' where you modify the controlled files.
The working copy folder is usually associated with a folder that exists within the
version control repository. Your version control product provides some means by

which you associate a working copy folder with a repository folder.

For further information, consult the documentation for your particular version
control product.

Notes

e When installing the client component software on users' PCs, check that the SCC client is also installed, as it might
not be a part of the default installation
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Upgrade at Enterprise Architect Version 4.5, Under SCC
Version Control

If you are working in Enterprise Architect release 4.5 or later and you open an SCC version-controlled project that was
created under a release earlier than 4.5, you must identify the SCC connection with a new unique ID. You can assign a
name to the existing SCC configuration or associate the project with another configuration that has previously been
assigned a unique ID.

By having a unique ID for each version control configuration, you can assign a configuration quickly and efficiently
using configurations that have been created previously for other version controlled repositories. This enables you to
configure the many Packages to use an existing version control repository; this can apply to Packages created for more
than just one model enabling a great deal of flexibility.

Upgrade an existing SCC version controlled project created before release 4.5, in
Enterprise Architect release 4.5 or later

Step Action

1 Open the project that has an SCC version control configuration created in Enterprise Architect earlier than
version 4.5.
The 'Select or Create Unique ID for Version Control' dialog automatically displays.

2 On the dialog, either create an ID for an existing configuration or choose a previously created one from
the 'Unique ID' drop-down list.

3 The existing SCC configuration is the initial value, represented by SCC-XXXXX; this number is not
especially meaningful, therefore it is recommended that the configuration be given a meaningful name.

4 You can associate the version controlled Package with a previously-defined configuration by selecting an
existing configuration from the Unique ID drop-down list (if one exists).

5 After you have assigned the unique ID, click on the OK button to load the model.

(c) Sparx Systems 2015 - 2017 Page 45 of 121 Created with Enterprise Architect



User Guide - Change Management 30 June, 2017

Version Control Setup

Once you or an Administrator have installed and configured the version control product software, to start using version
control you must first define a version control configuration within your project in Enterprise Architect, to be used to
control the Packages in the project. You can define any number of version control configurations in a single model, but
any given Package is associated with only one configuration.

Access
Ribbon Configure > Version Control > Settings
Context Menu Right-click on Package > Package Control > Version Control Settings

Define Version Control Configuration

Step Action

1

On the 'Version Control Settings' dialog, click on the New button.

2 In the 'Unique ID' field, type a suitable configuration name.

3 Select the Type of version control product you are connecting to, by clicking on the corresponding radio
button.

4 At this point, the middle section of the dialog changes to display a collection of fields specific to the type
of version control configuration you are defining.
Enter details relating to the version control workspace that this configuration is to use.

5 Click on the Save button. The new configuration is added to the Defined Configurations list.

6 If you want to create another version control configuration, return to step 1.
When you have finished defining your version control configurations, click on the Close button.

Notes

Version control configuration details are stored in the user's Windows Registry settings, but each project stores a list
of the configurations it uses, so that version control connections can be initialized as the project is being loaded

If you are using the Corporate or extended editions of Enterprise Architect with security enabled, the administrator
must also set up access permissions to configure and use version control

(c) Sparx Systems 2015 - 2017 Page 46 of 121 Created with Enterprise Architect



User Guide - Change Management 30 June, 2017

Re-use an Existing Configuration

Once a version control configuration has been defined for use in one project, it is possible to re-use that configuration in
other projects to provide access to:

e An already existing version control environment (a working copy directory and its associated repository that is
already in use)

e Version controlled Packages that were created (and version controlled) in another project

Access
Ribbon Configure > Version Control > Settings
Context Menu Project Browser | right-click on Package | Package Control | Version Control

Settings

Select existing configuration

Step Action

1 On the 'Version Control Settings' dialog, click on the New button.

The various fields on the dialog are cleared, ready for data entry.
2 In the 'Unique ID' field, click on the drop-down arrow and select one of the previously-defined version
control configurations.

The details of the selected configuration are displayed in the dialog.

3 Click on the Save button.

The configuration details are saved and are ready for use in the current project.
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Version Control Settings

Defining version control settings within Enterprise Architect should only be performed after you have successfully
created the version control environment that you intend to use to control your Package files. If you have not yet done so,
please refer to the Help topic Applying Version Control in a Team Environment for a summary of what is required.

To set up a version control configuration on your model, or update an existing version control configuration, you define a

number of settings that control how the status of your model is communicated to your version control system. You define
these settings using the 'Version Control Settings' dialog.

Access

Ribbon

Context Menu

Configuration Options

Option

This model is private

Save nested version
controlled packages to
stubs only

For all packages, create
placeholders for external
references

Unique ID

Type
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Configure > Version Control > Settings

Right-click on Package > Package Control > Version Control Settings

Action

Select to specify that this model database is to be accessed by just a single user
(Private Model).

Leave unselected (the default) or deselect to specify that the database is to be
accessed by multiple concurrent users (Shared Model).

If in doubt, use the default setting.

Select to specify that the exported XMI file for a version controlled Package will
contain Package stubs (place holders) for nested version controlled child Packages
(recommended).

Deselect to specify that the exported XMI file will contain the full content of nested
version controlled child Packages.

Select to force all XMI 1.1 imports across the model to exclude incoming
relationships and instead create external references.

If the 'Create placeholders for missing External References during XMI 1.1/2.1
Import' checkbox is not selected in the XML Specifications options for a user, this
field overrides that setting.

Specify a name that uniquely identifies the configuration. Either:
e Type a name to identify a new configuration, or

e  Click on the drop-down arrow and select the name of a configuration
previously defined in a different project (if any exist)

Click on the appropriate radio button for the type of version control system you are
associating with this configuration.

The middle section of the dialog changes to display a collection of fields relating to
the type of version control configuration you are defining.
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Set the type to SCC for:

e  MS Visual Source Safe

e Rational Clear Case

e Perforce

e AccuRev

e Any other SCC-compatible clients

For any other product that you are using, select the type that matches the product -
CVS, Subversion or TFS.

New Click on this button to clear the fields and create a new version control
configuration.

Save Click on this button to save the details of a new or updated configuration.

Delete Click on an entry in the Defined Configurations list and click this button to remove

the definition of the selected configuration from this model.

Defined Configurations Review a list of configurations that are in use in the current model.
In future, do not prompt for Select to specify that the user is not prompted to complete the definition of
incomplete configurations configurations that are not fully specified (the default).

Deselect to prompt the user to complete configurations that are not fully defined.

Close Close the 'Version Control Settings' dialog.
Help Display this Help topic.
Notes

e [tis important that, for any given version controlled Package file, any user accessing that file from any model uses
version control configurations having the same Unique ID

e When you first open a model that was created by another user and that uses version control, the version control
configuration(s) used by that model do not yet exist in your Windows registry settings; you need to complete the
definitions of those configurations before you can use version control in that project

e If User Security is enabled, you must have 'Configure Version Control' permission to set up version control options
for the current model

e [t is possible to use multiple version control configurations in the same model
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SCC Settings

When you are setting up your version control configurations on the 'Version Control Settings' dialog, and you set the
configuration type to 'SCC', the dialog presents a set of fields specific to SCC-based configurations. You can then define
details such as:

The working copy folder to be used with the configuration

The details necessary to connect to the SCC version control system

You set the version-control configuration type to SCC for version control providers such as:

e  MS Visual Source Safe
e Rational Clear Case
e Perforce
e AccuRev
e  Any other SCC-compatible clients
Access

Ribbon Configure > Version Control > Settings: Type: SCC

Context Menu Right-click on Package > Package Control > Version Control Settings: Type: SCC
Settings

Option Action

Local Project Path Displays the full path of the folder that contains the local (working) copies of the

XMI Package files.

This field is read-only; its value can only be set through use of the Select Path

button.

Select Path Click on this button to choose the Local Project Path, by opening a file browser
dialog and navigating through the file system to the appropriate folder.

e After you choose the appropriate folder path, the 'Select SCC Provider' dialog
displays, listing all SCC providers that are installed on the current workstation;
choose the SCC provider to use and click on the OK button

e At this point, the SCC client opens its own dialog to prompt you for
information; SCC products implement this functionality in varied ways, but
typically you are prompted to log in to the version control system, then
prompted to choose the SCC project to use and possibly a (server) folder
contained within that project

e At the conclusion of this process, all of the SCC details should be filled in; you
can then save the definition by clicking on the Save button on the 'Version
Control Settings' dialog

Current User Displays the user name used to log on to the version control system that is accessed

through this configuration.
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This field is read-only; the value it displays is retrieved from the SCC client.

SCC Provider Displays the name of the SCC provider.
This field is read-only; the value it displays is retrieved from the SCC client.

SCC Project Displays the name of the SCC Project that this configuration attaches to.
This field is read-only; the value it displays is retrieved from the SCC client.

Notes

e You define the SCC-specific details as part of the broader process of setting up a version control configuration on
the 'Version Control Settings' dialog
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CVS Settings

When you are setting up your version control configurations on the 'Version Control Settings' dialog, and you set the
configuration type to CVS, the dialog presents a set of fields specific to CVS-based configurations. You can then define
details such as:

e The working copy folder to be used with the configuration

e The path to the CVS command line client

Access
Ribbon Configure > Version Control > Settings: Type: CVS
Context Menu Right-click on Package > Package Control > Version Control Settings: Type: CVS
Settings
Option Action

Working Copy Path Displays the full path of the folder that contains the local (working) copies of the
XMI Package files.

This field is read-only; its value can only be set through use of the Select Path
button.

Select Path Click on this button to choose the working copy path, by opening a file browser
dialog and navigating through the file system to the appropriate folder.

Current User This field is read-only; its value is retrieved from a file named CVS\Root, located
in the folder selected using the Select Path button.

CVS Exe Path Displays the full path of the CVS command line client executable file.

This field is read-only; its value can only be set through use of the Select Path
button.

Select Path Click on this button to specify the path to the CVS command line client, by opening
a file browser dialog and navigating through the file system to locate the
appropriate file.

VC Time-Out Value Specify the amount of time that Enterprise Architect waits for a CVS command to
complete; if the command does not complete within the allowed time, the system
displays a Time-out error message, detailing the command that failed to complete.
This single time-out value is applied to all Version Control Configurations (of types
SVN, TFS and CVS) that the user accesses from this workstation.

Notes
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e When connecting to a remote CVS repository, the 'Current User' field should display the user name used to log into
that repository; if this does not happen, it indicates that Enterprise Architect cannot extract the user name from the
file ...\WorkingCopyPath\CVS\Root and the configuration does not work correctly

e You define the CVS-specific details as part of the broader process of setting up a version control configuration on
the 'Version Control Settings' dialog
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SVN Settings

When you are setting up your version control configurations on the 'Version Control Settings' dialog, and you set the
configuration type to 'Subversion', the dialog presents a set of fields specific to Subversion-based configurations. You
can then define details such as:

e The working copy folder to be used with the configuration

e The path to the Subversion command line client

Access

Ribbon Configure > Version Control > Settings: Type: Subversion

Context Menu Right-click on Package > Package Control > Version Control Settings: Type:
Subversion

Settings
Option Action

Working Copy Path Displays the full path of the folder that contains the local (working) copies of the
XMI Package files.

This field is read-only; its value can only be set through use of the Select Path
button.

Select Path Click on this button to choose the Working Copy Path, by opening a file browser
dialog and navigating through the file system to the appropriate folder.

Subversion Exe Path Displays the full path of the Subversion command line client executable file.

This field is read-only; its value can only be set through use of the associated Select
Path button.

Select Path Click on this button to specify the path to the Subversion command line client, by
opening a file browser dialog and navigating through the file system to locate the
appropriate file.

VC Time-Out Value Specify the amount of time that Enterprise Architect should wait for a Subversion
command to complete; if the command does not complete within the allowed time,
the system displays a Time-out error message, detailing the command that failed to
complete.

This single time-out value is applied to all Version Control Configurations (of types
SVN, TFS and CVS) that the user accesses from this workstation.
Notes
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e  You define the Subversion-specific details as part of the broader process of setting up a version control
configuration on the 'Version Control Settings' dialog
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TFS Settings

When you are setting up your version control configurations on the 'Version Control Settings' dialog, and you set the
configuration type to "TFS', the dialog presents a set of fields specific to TFS-based configurations. You can then define
details such as:

e The working copy folder to be used with the configuration
e The user name and password to log in to the TFS server

e  The path to the TFS command line client

Access
Ribbon Configure > Version Control > Settings: Type: TFS
Context Menu Right-click on Package > Package Control > Version Control Settings: Type: TFS
Settings
Option Action

Working Copy Path Displays the full path of the folder that contains the local (working) copies of the
XMI Package files.
This field is read-only; its value can only be set through use of the associated Select
Path button.

Select Path Click on this button to choose the Working Copy Path. The file browser dialog
opens, through which you navigate through the file system to the appropriate folder.

Server Name Displays the name of the TFS Server that is associated with the working copy
folder specified in the "Working Copy Path' field.
This field is read-only; Enterprise Architect retrieves the value it displays by
querying the TFS client.

Workspace Name Displays the name of the TFS Workspace that is associated with the working copy
folder specified in the "Working Copy Path' field.
This field is read-only; Enterprise Architect retrieves the value it displays by
querying the TFS client.

User Name Type in the user name with which to log into the TFS Server.

Password Type in the password with which to log into the TFS Server.

Display Name TFS 2013 and later releases use a Display Name to report on who owns a checkout

lock on a file. TFS 2010 uses AccountID when reporting lock owners and so does
not require a Display Name.

If using TFS 2013, type in your TFS Display Name as shown in the User column of

(c) Sparx Systems 2015 - 2017 Page 56 of 121 Created with Enterprise Architect



User Guide - Change Management 30 June, 2017

the Visual Studio Source Control Explorer when you checkout a file.

Checkout Locks Required This checkbox defaults to selected.

TFS 2013 supports the use of Local workspaces, but these do not support checkout
locks. If you want to use TFS Local workspaces (not recommended), you must
deselect this checkbox. Otherwise, leave the checkbox selected.

It is recommended that all workspaces used for version controlling Enterprise
Architect Package files are set as 'Server' workspaces.

TFS Exe Path Displays the full path of the TFS command line client executable file.
This field is read-only; its value can only be set through use of the associated Select
Path button.

Select Path Click on this button to specify the path to the TFS command line client.

The file browser dialog opens, through which you navigate through the file system
to the appropriate folder.

VC Time-Out Value Type in the number of seconds that Enterprise Architect should wait for a TFS
command to complete; if a command does not complete within this allowed time,
the system displays a Time-out error message, detailing the command that failed to
complete.

This single time-out value is applied to all version control configurations (of types
SVN, TFS and CVS) that the user accesses from this workstation.

Notes

e Ifyou automatically log in to TFS through a path external to Enterprise Architect (for example, through MS
Integrated Security), you can leave the 'User Name' and "Password' fields blank

e Ifthe 'Password' field is blank, Enterprise Architect retrieves your Windows username and uses that value when
determining whether a Package file is checked out to you or to another user

e TFS version control can also be accessed using the TFS MSSCCI client; to make use of the TFS MSSCCI client,
please define an SCC based version control configuration

e  You define the TFS-specific details as part of the broader process of setting up a version control configuration on the
"Version Control Settings' dialog
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Use Version Control

Once your version control product is installed and you have created a suitable environment, Enterprise Architect can
make use of that environment to control the Packages in your project. Version control provides a range of facilities, as

outlined in this table.

Facilities

Facility

Define Version Control
Settings

Configure a Package

Check In a Model Branch

Check Out a Model Branch

Check In a Package

Check Out a Package

Undo Check Out of a
Package

Import a Package From
Version Control

Apply Version Control to a
Model Branch

Export a Version
Controlled Model Branch

Import a Model Branch
From Version Control
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Detail

Version control configurations are used by Enterprise Architect to communicate
with your version control system.

You define one or more version control configurations in your project and then use
those configurations to control the Packages in your project.

To put a Package under version control you mark the Package as a controlled
Package, specify the version control configuration to control it, and associate an
XMI file with the Package.

Checks in all Packages involved in a particular unit of work, as a single operation.

Checking-in updates the reference version of a Package or group of Packages in the
model.

Checks out all Packages within a selected model branch as a single operation, so
that you can update modeling objects within them.

Checks in the Package currently selected in the Project Browser.

Checking-in updates the reference version of a Package or group of Packages in the
model.

Checks out the version controlled Package currently selected in the Project
Browser, so that you can update modeling objects within it.

Reverses the check-out of a Package, discarding any modifications that have been
made by restoring the Package content to the latest revision held in version control.

Retrieves Packages from version control that have been created by other users, or
by you in another model, and imports them into your current model.

Applies version control to all Packages within the selected model branch, in a
single operation.

In this context, a model branch is a Package in the Project Browser, and all of the
Packages contained within it.

Exports version control information about the root Package of a model branch, that
is used to simplify the process of exporting and importing a hierarchy of Packages
from one model to another.

Uses Enterprise Architect's Model Branch files, of which there are few, to retrieve
information about the root Package file and to import the model branch.

Model branch files can simplify the process of exporting and importing a hierarchy
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of Packages from one model to another.

View Package Revision Displays the change history of version controlled Packages.

History You can also check out a prior revision of the Package for editing, effectively

rolling-back to a prior revision of the Package.

Validate Package You can test the validity of the version control settings associated with each version
Configurations controlled Package within your current model.
Resynchronize the Status Re-synchronizes the version control status of Packages within your project with the
of Version Controlled status reported by your version control provider.
Packages

Notes

e Database replication should not be combined with version controlled Packages

e If the Packages under version control contain any alternative images, you can export the images to the version
control repository when you check in the Packages, by setting the 'Export alternate images' option on the
'"Preferences' dialog

(c) Sparx Systems 2015 - 2017 Page 59 of 121 Created with Enterprise Architect



User Guide - Change Management 30 June, 2017

Configure Controlled Package

Once your version control application is set up and you have version control configurations in place, you can place the
individual Packages in your model under version control. To put a Package under version control, you:

e Flag the Package as a controlled Package
e Specify the version control configuration to control it and
e Associate an XMI file with the Package

You can then export and import the Package data to and from the file and issue commands to the version control system.

Access
Ribbon Configure > Version Control > Configure Package
Context Menu Right-click on Package > Package Control > Configure
Keyboard Shortcuts Ctrl+Alt+P

Apply version control to a single Package

Step Action

1 Click on the 'Control Package' checkbox to select it, indicating that this Package is to be controlled.

2 Click on the Version Control drop-down arrow and select the version control configuration to be used to
control this Package.

3 The 'XMI Filename' field displays a default filename for the Package export file, based on the Package
name.

Optionally, modify the filename. Either:

e Type a new name, or

e (Click on the E] button to open a file selection dialog

The target file must be located within the working copy folder of the selected version control
configuration, or one of its sub-folders.

4 The 'Version ID' field defaults to '1.0'.

Optionally, change this to a different version number.

5 The 'Owner’ field defaults to your user name.

Optionally, type or select the name of the user who actually owns the Package.

6 Click on the OK button.
The 'Add Package to Version Control' dialog displays.
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7 Optionally, clear the 'Keep checked out' checkbox.

After applying version control, the Package either remains checked-out for editing, or is checked-in and
locked against editing, depending on this setting.

8 Click on the OK button.
The 'Add Comment' dialog displays.

9 Optionally, add any further comments to the default comment.

Enterprise Architect provides a default comment that includes the current date & time.

10 Click on the OK button.

The current Package is exported to the nominated XMI file, which is then committed to version control.
The Package icon in the Project Browser is updated to reflect the Package's version control status.

Notes

e Ifyou are using the Corporate or extended editions of Enterprise Architect with security enabled, these features are
only available to users who have been granted permission to configure and use version control
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Apply Version Control To Branches

It is possible to apply version control to all Packages within a selected model branch, in a single operation. In this
context, a model branch is a Package that is currently selected in the Project Browser, and all of the Packages contained
within it.

Access

Context Menu Project Browser | right-click on Package | Package Control | Add Branch to Version
Control

Apply version control to all Packages within a selected model branch

Step Action

1 On the 'Apply VC to Branch' dialog, click on the drop-down arrow in the "Version Control Configuration'
field and select the configuration to use.

2 Optionally, tick the checkbox 'Export as Model Branch'.

Once the version control operation is complete a Model Branch file (.(EAB file) is created for this branch.

3 Click on the OK button.

The system creates a number of sub-folders within the version control working copy folder, then exports
all of the Packages within the selected model branch. The system generates filenames for the XMI files,
based on the Package GUIDs.

Notes
e  The version control configuration to be used in this operation must be defined within the model before selecting this

command

e When invoked on the model root node, this command applies version control to every Package within the model
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Package Version Control Options

When you have set up a Package for version control, you gain access to a range of version control operations that can be
performed on that Package, such as:

e Open the dialog for working with baselines of the Package

e  Check-in and check-out single Packages or a selected hierarchy of Packages

e  Update Packages to the latest revision from the version control repository

e Inspect the revision history or properties of the XMI file associated with a Package

e Revert a Package to a previous revision

e  Compare the current model content of a Package, against the latest revision of the Package in version control

e Import and export hierarchies of Packages (model branches) to and from the model, through the version control
system

e Synchronize the status of a Package, with the version control system

Access
Context Menu Right-click on version controlled Package > Package Control
Options
Option Action

Configure Apply or remove version control for the selected Package (specify version control
settings) or specify a file for use in XMI Package Control.
Shortcut: Ctrl+Alt+P

Package Baselines Create a Baseline of the current Package, or compare the current Package with a
previous Baseline.
Shortcut: Ctrl+Alt+B

Check In Branch Check-in Packages contained in the currently selected model branch (that is, the
selected Package and all of its child Packages).

The 'Select Packages to Check In' dialog lists all version controlled Packages within
that branch that are checked out to you; you can then select Packages in the
displayed list, to be submitted for check-in.

You can also choose to keep the Packages checked-out after committing a new
revision to version control.

Check Out Branch Recursively check out all Packages contained within the currently selected model
branch (that is, the selected Package and all of its child Packages) that are version
controlled and checked-in.

Check In Commit a new revision of the currently selected Package to the version control

repository and lock the Package against further editing.
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Check Out

Undo Check Out

Put Latest

Get Latest

Get All Latest

Scan XMI and Reconcile
Model
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Only available for Packages that you have checked-out yourself.

Synchronize the currently selected Package with the latest revision from the version
control repository and unlock the Package to allow editing.

Only available for Packages that are not already checked-out (and whose associated
Package file is not checked-out).

Restore the selected Package to the latest revision in the version control repository
and lock the Package against further editing.

Commit a new revision of the currently selected Package to the version control
system, while keeping the Package checked-out.

This is equivalent to checking a Package in and immediately checking it back out
again.

Only available for Packages that you have checked-out yourself.

Synchronize the currently selected Package with the latest revision from the version
control repository.

Available only for Packages that are checked in.

Update all of the version controlled Packages in the project, to the latest revision
retrieved from version control.

Only updates Packages that are currently checked in.

Once the latest revisions are retrieved, the system scans all the controlled Packages
and fixes any missing cross-references by comparing the Package with its XMI 1.1
file.

If the cross-reference information in the XMI does not match the model, the system
updates the model with the information from the XMI and records this update in the
System Output window.

You can roll back such updates by selecting the entry in the System Output window
and using the context menu option 'Rollback Update' (or 'Rollback Selected
Updates' if multiple entries are selected).

e C(Closing the model clears the entries in the System Output window

e An entry in the System Output window is also cleared as and when you
roll-back the update for it

Scan the Package XMI files associated with each of the project's controlled
Packages and restore any diagram objects or cross-references that are detected as
missing from the project.

This function is useful in team environments where each user maintains their own
private copy of the model database (that is, multiple private project files) and model
updates are propagated through the use of controlled Packages. It provides no
benefit when the model is hosted in a single shared database that is accessed by all
team members.

Each controlled Package is compared with its associated XMI file and, if the
cross-reference information in the model does not match the XMI, the system
updates the model with the information from the XMI and records the update in the
System Output window.

You can roll back such updates by right-clicking on the entry in the System Output
window and selecting the 'Rollback Update' option (or 'Rollback Selected Updates'
if multiple entries are selected).

Closing the model clears the entries in the System Output window; an entry in the
window is also cleared as and when you roll-back the update for it.
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File Properties

File History

Compare with Controlled
Version

Add Branch to Version
Control

Export as Model Branch

Import a Model Branch

Get Package

Re-synch Status With VC
Provider

Version Control Settings
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This functionality is invoked automatically as part of the 'Get All Latest' operation.

When working in an environment that uses a Private Model deployment and your
model contains a significant number of cross-Package references, it is
recommended that you invoke 'Scan XMI and Reconcile Model' from time to time,
following the re-importation of controlled Packages - for example, after using 'Get
Latest' to update a number of Packages - or after performing a number of Package
check-outs.

e Asageneral rule, avoid running 'Scan XMI and Reconcile Model' while you

have uncommitted changes in your model; generally, you:

- Check-out a number of Packages

- Invoke 'Scan XMI and Reconcile Model'

- Make your modifications

- Commit any outstanding changes before you check-out more Packages and
run 'Scan XMI and

Reconcile Model' again

Display version control properties pertaining to the XMI export file associated with
the currently selected Package; this also identifies who has checked out the
Package.

Display change history information for the currently selected Package.

Revert to or check-out a prior revision of the Package.

Compare the currently selected Package with the latest revision of its associated
XMI file retrieved from version control.

Apply version control to all Packages within a selected model branch, in a single
operation.

In this context, a model branch is a Package that is currently selected in the Project
Browser, and all of the Packages contained within it.

Export a newly created model branch from your own private copy of a model.

Retrieve a model branch and import it into either the source model or another
model.

Access Packages in the version control repository that are not currently available in
your model.

Update the version control status value recorded for the selected Package in the
project to match the value reported by the version control provider, without
performing an XMI import or export.

Use this function when the Package's version control status recorded in your project
is out of synchrony with the version control status reported by your version control
provider.

Display the 'Version Control Settings' dialog.

Notes

e You set up version control using options from the project 'Version Control' submenu
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e If'the selected Package is not under version control, a different set of options is available

e Ifaversion control configuration has not been defined for the model, no options for using version control are
available, only the options for configuring version control
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Check Out a Package

When you need to work on a version controlled Package, you check it out. The local XMI file associated with the
Package is then checked-out from version control. No other user can check out the Package to make changes to it until it
has been checked in again.

Access
Context Menu Right-click on Package > Package Control > Check Out
Keyboard Shortcuts Ctrl+Alt+L

Check out a single Package

The Package file is imported into your model, and the 'Package' icon is updated to reflect the change in the Package's
version control status.

When working in a Private Model, if the system detects that the Package content in the model is already up to date with
the latest revision of the Package file retrieved from version control, then the 'Tmport Package' dialog displays first. This
dialog is not displayed for a Shared Model.

These options are available:
e Force Reload From XMI - reload the Package from XMI regardless of whether it is up to date or not
e Accept current package - select to skip the process of re-importing the Package from XMI

e Refresh model view - select to refresh the Project Browser and diagrams, by reloading the Package content from the
project database

e Always use these settings - when selected, if you subsequently check out a Package that is found to be up to date, the
same settings are applied again without displaying the dialog

Notes

e If you check out a version controlled Package whilst offline, the 'Package' icon has a red figure 8 in front of it

e Ifyou have selected the 'Always use these settings' checkbox and you want to reconfigure the 'Tmport Package'
dialog, press the Ctrl key whilst you select the 'Package Control | Check Out' context menu option; the dialog
displays and you can change the settings
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Undo Check Out of a Package

If you check out a Package and then decide not to proceed, you can undo the check-out and discard any modifications
that have been made, by restoring the Package content to the latest revision held in version control. The Package returns
to a checked-in state and subsequently can be checked out by any user, including yourself if, for example, you need to
reverse incorrect changes before checking the Package out and starting again.

Access

Context Menu Right-click on Package > Package Control > Undo Check Out

Undo check out of a selected Package

A confirmation dialog displays; click on the OK button.

The latest revision of the Package is retrieved from version control and re-imported into your model. The icon against the
Package in the Project Browser is updated to reflect the change in the Package's version control status.
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Check In a Package

When you have finished working on the contents of a Package under version control, and you want to return it to the
model for other users to see, you check it in.

Access
Context Menu Right-click on Package > Package Control > Check In
Keyboard Shortcuts Ctrl+Alt+S

Check in a single Package

Step Action

1 The selected Package is exported and the 'Add Comment' dialog displays. A default comment is provided
that contains the current date and time.

Optionally, modify the default check-in comment
2 Click OK.

The Package file is checked-in to version control and the Package icon is updated to reflect the change in
version control status.
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Check Out a Model Branch

If you need to check out a number of related Packages involved in a particular unit of work, to update the contents, you
can do so in a single operation by checking out the whole model branch that contains them.

Access

Context Menu Right-click on Package > Package Control > Check Out Branch

Check out a sub-tree of model Packages

Step Action

1 The selected root-node Package and all of its contained sub-Packages are recursively checked out.

Any Packages that cannot be checked-out are listed in a message box, with a brief description of the
problem; for example: The Package is already checked out by user 'Fred'.

2 When Project Security is enabled in Lock to Edit mode, Enterprise Architect prompts you to apply a User
Lock throughout the selected model branch before proceeding.
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Check In a Model Branch

If you need to check in a number of related Packages involved in a particular unit of work, and that you have updated,
you can do so in a single operation by checking in the whole model branch that contains them. You can also commit new
revisions of the affected Packages as you complete milestones, whilst keeping the Packages checked-out for further
editing.

Access

Context Menu Right-click on Package > Package Control > Check In Branch

Check in Packages from within a model branch

Step Action

1 The 'Select Packages to Check-in' dialog lists all version controlled and checked-out Packages within the
selected model branch. By default, the entire list is selected.

Optionally:

e  Click an individual Package to select just that Package

e  Ctrl+click on an individual Package to add or remove it from the selection
e  Shift+click on a range of Packages to select them

e  Click on the All button to select all listed Packages

e  Click on the None button to clear the selection

2 Optionally, you can commit into version control a new revision of all selected Packages, while keeping
those Packages checked out for further editing. To do this, select the 'Keep packages checked-out after
committing new revision' checkbox.

3 Click on the OK button.

The 'Add Comment' dialog displays. A default comment is provided that contains the current date and
time. This comment is applied to all Packages that are checked in.

4 Optionally, modify the default check-in comment.

5 Click on the OK button.

The selected Packages are exported and checked-in. The Package icons are updated to reflect any change
in version control status. If you opted to keep Packages checked out, there is no change in status.
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Update to the Latest Revision of Selected Package

When you are part of a team working in a Distributed Model environment, you will want to periodically update your
model with the changes that other team members have committed into version control. You can transfer the other users'
updates from version control into the selected Package in the Project Browser.

Access

Context Menu Right-click on Package > Package Control > Get Latest

Update Package to latest revision

The local XMI file associated with the Package is updated to the latest revision from version control. The XMI file is
imported into your model database, updating the Package in your model.

When working in a Private Model, if the system detects that the Package content in the model is already up to date with
the latest revision of the Package file retrieved from version control, then the 'Import Package' dialog displays first. This
dialog is not displayed for a Shared Model.

These options are available:
e 'Force Reload From XMI' - reload the Package from XMI regardless of whether it is up to date or not
e 'Accept current package' - select to skip the process of re-importing the Package from XMI

o 'Refresh model view' - select to refresh the Project Browser and diagrams, by reloading the Package content from the
project database

e 'Always use these settings' - when selected, if you subsequently check out a Package that is found to be up to date,
the same settings are applied again without displaying the dialog

Notes

e  The 'Get Latest' command is disabled for any Package that is checked-out (to anybody) in the currently loaded
project

e When using a Shared Model environment, where all users are connected to a single model database, you should
reload the Package from the database, rather than using the 'Get Latest' command

e Ifyou have selected the 'Always use these settings' checkbox and you want to reconfigure the 'Tmport Package'
dialog, press the Ctrl key whilst you select the 'Package Control | Get Latest' context menu option; the dialog
displays and you can change the settings
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Update to the Latest Revision of All Packages

When you are part of a team working in a Distributed Model environment, you will want to periodically update your
model with the changes that other team members have committed into version control. You can transfer the other users'
updates to all version controlled Packages into the currently loaded project.

Access

Context Menu Right-click on Package > Package Control > Get All Latest

Update all Packages in project to latest revision retrieved from version control

All the local XMI files for all the version control configurations used in the project are updated to the latest revision from
version control. The system then scans the Packages in the model, to determine which ones are up to date and which are
not, compared to the latest revisions of the associated Package files.

A prompt displays, providing these import options for Packages that are up to date:
e Import changed files only

e  Always import

e  Prompt for each file

Click on the OK button. The version controlled Packages in your project are updated according to the option you
selected; if you chose the 'Prompt for each file' option, a prompt displays to confirm import of each file.

Notes

e There is no need to re-import Packages that are already up to date - re-importing Packages first deletes them from
the project and then re-imports them from the XMI file, which is time consuming as well as unnecessary; we
strongly recommend using the default option 'Import changed files only'

e  The 'Get All Latest' command does not update any Package that is checked-out (to anybody) in the currently loaded
project; otherwise, any changes not yet committed to version control would be discarded

e  When using a Shared Model environment, where all users are connected to a single model database, the information
in the model database is always the same as, or ahead of, what is committed into version control; in this situation,
the Get All Latest command will simply refresh your view of the model database, by reloading diagrams or
reloading Package content in the Project Browser
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Include Other Users' Packages

Other users might be developing Packages in their own models that you could use in your model, or you might have
other models containing Packages that you want to use in the current model. Unless you are sharing an SQL database or
project file, those Packages are not automatically available to you. However, if the Packages have been placed into
version control, you can import them into your model as children of one of your model's Packages.

Access

Context Menu Right-click on Package > Package Control > Get Package

Import Packages from version control into current model

Step Action

1 On the 'Get Shared File' dialog, click on the drop-down arrow of the 'Version Control Configuration' field
and select the version control configuration associated with the Package to retrieve.

The file list is populated with the names of files available through that configuration, for retrieval and
import into your model.

2 Click on the Package file to import into your model and click on the OK button.

The Package file is imported as a new child Package, under the parent Package you selected.

Notes

e  You must have access to the Package files through the version control system and you must define a version control
configuration through which to access those files

e  The version control configuration must use the same unique ID that was originally used to add the Package to
version control

e XMI Package files associated with Packages that are already part of your project, are NOT included in the list of
files available for import
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Export Controlled Model Branch

Applying version control to a model can result in many XMI files placed under version control. It might then be hard to
locate and import the file corresponding to the root of a particular model branch. Using Model Branch Files (.eab files)
overcomes this problem by making it easier to export and import Package hierarchies from one model to another.

You could export a newly created model branch from your own private copy of a model so that, for example:
e Another user can import that branch into their own private copy of the same model

e It can be imported for inclusion as a common branch in a number of different models

Access

Context Menu Right-click on Package > Package Control > Export as Model Branch

Create a Model Branch File to represent a Package hierarchy stored in version
control

Step Action

1 On the 'Export as Model Branch' dialog, in the 'EAB Filename' field, type a name for your Model Branch
File.

Alternatively, click on the D button and browse for the file location.
Note that the Package name is supplied as a default.

2 Click on the OK button.

A branch file is created to represent the selected Package. The branch file is committed to version control
using the same version control configuration that controls the Package you selected.

Notes

®  You can specify any file name, including sub-folder names, as long as the file is contained in or below the working
folder of your version control configuration

e  The facility is only enabled for Packages that are already under version control
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Import Controlled Model Branch

Applying version control to a model can result in many XMI files placed under version control. It could then be hard to
locate and import the file corresponding to the root of a particular model branch, if you want to:

e Retrieve a model branch created by another user in a private copy of a model, to import it into your own private
copy of the same model

e Retrieve a model branch that is common in many models, for inclusion in a new model

Model Branch Files overcome this problem by simplifying the retrieval of Package hierarchies for use in other models.
You use Enterprise Architect's Model Branch Files, of which there are few, to retrieve information about the root
Package file such as the name and type of the version control configuration for the selected Package, and the relative
filename of the version controlled XMI file associated with the Package. The system then uses this information to import
the branch into your model.

Prerequisites

Before you begin, you must have:
e An operational version control environment that can be accessed by Enterprise Architect, and

e All of the version controlled Package files and the model branch file associated with the model branch to import, in a
valid and accessible working copy folder

Access

Context Menu Right-click on target Package for import > Package Control > Import a Model
Branch

Import a Model Branch

Step Action

1 On the 'Import VC Model Branch' dialog, either:

e  Use the lower portion of the dialog to select a model branch file (this is the simpler option if the
associated version control configuration has already been saved in the current model; continue to step
2)
OR

e  Click on the Find a Model Branch (.EAB) file button (this option is useful when you have not yet
defined the version control configuration that is associated with the model branch to be imported; see
the Manually Locating Model Branch Files topic)

2 Click on the drop-down arrow in the 'Select a Version Control Configuration' field and select a
configuration.
A list of .eab files controlled by that configuration is displayed in the 'Select a Model Branch (.EAB) file'
list.

3 Select the Model Branch File you need, then click on the OK button.
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The system imports the root Package specified in the Model Branch File and recursively imports and
populates all the sub-Packages contained in the root Package.

Notes

e The Import a Model Branch command is only enabled for Packages that you (the current user) are able to edit, as the
imported model branch is inserted into the model under your selected Package
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Manually Locating Model Branch Files

When importing a Model Branch File from version control, you might not have the associated version control
configuration saved in the model that is receiving the import. In this situation, it is simpler to manually browse the file
system to locate the Model Branch File (.eab) and let Enterprise Architect derive the details of the configuration from the
branch file you select.

Prerequisites

Before you begin, you must have:
e An operational version control environment that can be accessed by Enterprise Architect, and

e All of the version controlled Package files and the model branch file associated with the model branch to import, in a
valid and accessible working copy folder

Access

Context Menu Right-click on target Package for import > Package Control > Import a Model
Branch : Find a Model Branch (.EAB) file

Locate the Model Branch File

Step Action

1 Access the Tmport VC Model Branch' dialog, then browse for and select the Model Branch File that
represents the model branch to import.

2 Click on the Open button.

If the version control configuration referenced by the file is fully defined within the current model, the
import commences at this point.

Otherwise, Enterprise Architect displays a dialog prompting you to complete the required configuration.

3 Click "Yes' to proceed with completing the definition of the version control configuration.

The 'Version Control Settings' dialog is displayed.

4 Complete the definition of the configuration.

(Typically this involves simply specifying the working copy folder.)

5 Click on the Save button.
The configuration details are saved.

The import of the model branch proceeds.
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Notes

e The Import a Model Branch command is only enabled for Packages that you (the current user) are able to edit, as the
imported model branch is inserted into the model under your selected Package
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Review Package History

It is possible to review the change history of version controlled Packages by examining previous revisions. If necessary,
you can check out one of these earlier revisions of a Package for editing, effectively rolling-back to that prior revision of
the Package.

Access

Context Menu Right-click on Package > Package Control > File History

Review change history of a version-controlled Package

Step Action

1 For version control environments using Subversion, CVS or TFS command line clients, the 'File Version
History' dialog displays.

Click on a revision number in the 'Revisions' field, to select that revision and view its log entry.

For version control environments using SCC based clients, your particular product opens its own 'File
Version History' dialog.

2 On the 'File Version History' dialog, you can optionally click on either:

e  Check Out - the selected revision of the Package file is retrieved from version control and imported
into your model as a Package that is checked out for editing; you can subsequently check in this
revision as a new HEAD revision, effectively allowing you to revert the Package to a prior revision
or

e Retrieve - the selected revision of the Package file is retrieved from version control and imported into
your model, but the Package remains flagged as checked-in and cannot be modified; subsequently
checking out the Package updates it to the latest revision before it is unlocked for editing

Notes

e Ifthe selected Package was already checked out in the current model, the Retrieve and Check Out buttons are
disabled

e Ifthe selected Package contains any sub-Package that is already checked-out in the current model, a warning will be
displayed and the retrieval or check-out will not go ahead

e Ifyou check out a prior revision of a Package, but do not want to commit it as a new revision, right-click on the
Package and select Package Control | Undo Check Out
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Review Package History - SCC Client

It is possible to review the change history of version controlled Packages by examining previous revisions. If necessary,
you can check out one of these earlier revisions of a Package for editing, effectively rolling-back to that prior revision of
the Package. The process for reviewing the change history of Packages configured for version control with an SCC client
(including products such as Visual Source Safe, TFS-SCC, ClearCase, Perforce, AccuRev and MKS Source Integrity)
differs from that for Subversion, CVS or TFS command line clients.

Access

Context Menu Right-click on Package > Package Control > File History

Review change history of a version-controlled Package (SCC client)

Step Action

1 The change history mechanism offered by the third party SCC provider displays.

To import a prior revision of the Package into your model, use the 'SCC History' dialog to retrieve the
revision, then close the dialog.

2 The SCC client notifies Enterprise Architect that a different revision has been retrieved. A prompt then
displays, asking whether you want to check-out the prior revision.

3 Optionally, click on either:

®  Yes, to check out the prior revision - the selected revision of the Package file is retrieved from
version control and imported into your model as a Package that is checked out for editing; you can
subsequently check in this revision as a new HEAD revision, effectively reverting the Package to the
prior revision
OR

e No, to import the prior revision as read-only - the selected revision of the Package file is retrieved
from version control and imported into your model, but the Package remains flagged as checked-in
and cannot be modified; subsequently checking out the Package updates it to the latest revision before
it is unlocked for editing

Notes

e Ifthe selected Package was already checked out in the current model, the system does not proceed with retrieving a
prior revision

e Ifyou check out a prior revision of the Package, but do not want to commit it as a new revision, right-click on the
Package and select 'Package Control | Undo Check Out'
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Retrieve Prior Revision - SCC Client

Depending on your version control product, retrieving a prior revision of a controlled Package can involve a number of
prompts regarding overwriting the current local copy.

This example details retrieval of a prior revision from a TFS-SCC version control configuration.

Access

Context Menu Right-click on Package > Package Control > File History

Example Procedure - retrieve prior revision, TFS-SCC client

Step Action
1 Display the 'TFS File History' dialog.

2 Click on the Get button.
The TFS-SCC client displays the '"Resolve Conflicts' dialog.
This dialog offers the 'Automerge All XML Package files' option. DO NOT select this option.
It is important to prevent any merging of Enterprise Architect's XML Package files.

3 Click on the Resolve button.
The TFS-SCC client displays the 'Resolve writable file conflict' dialog.

4 Select the 'Overwrite local file/folder' option.
The existing working copy of the Package file is overwritten by the prior revision retrieved from version
control.

5 Click the OK button.

The TFS-SCC client redisplays the 'Resolve writable file conflict' dialog; it should now show no conflicts.

6 Click on the Close button.
The TFS-SCC client redisplays the 'File History' dialog.

7 Click on the Close button.

Enterprise Architect displays a prompt, asking whether to check-out the prior revision.

8 Click on the:
®  Yes button to check-out the prior revision

e No button to retrieve a read-only version of the Package, that is NOT checked-out and is NOT
editable

(c) Sparx Systems 2015 - 2017 Page 82 of 121 Created with Enterprise Architect



User Guide - Change Management 30 June, 2017

Validate Package Configurations

Having defined the version control settings for your current model, you can test the validity of those settings associated
with each version controlled Package within the model.

Access

Ribbon Configure > Version Control > Check Configuration

Validate version control settings

Step Action

1 The validation process scans the model database and verifies that the version control configuration
associated with each version controlled Package is fully specified in the current model. It also queries the
corresponding version control provider to find the status of the Package file associated with each version
controlled Package.

The results of the validation process are sent to the System Output window.

2 Open the 'Version Control Settings' dialog to complete the definition of any invalid or missing version
control configurations.

3 Click on an error message in the System Output window to highlight the corresponding Package in the
Project Browser.

4 Right-click a Package node and select 'Package Control | Configure Package' to open the "Package Control
Options' dialog.

Correct any problems with the version control details for the Package.

Correct any problems with the Package's associated XMI file.
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Resynchronize the Status of Version Controlled Packages

It is possible to update the version control status of version controlled Packages within your project to re-synchronize
with the status reported by your version control provider. This can be useful if you are creating copies of your project,
where checking in a Package from one copy of the model leaves the Package in the second copy of the model with an
out-of-date version control status.

For a given Package, the re-synchronization process queries the corresponding version control provider to find the status
of the Package file associated with the version-controlled Package. If necessary, the process then updates the Package
flags within the model database, to synchronize the Package status recorded in the model with the value reported by the
version control provider.

Access
Ribbon Configure > Version Control > Re-Synch Status (applies to all Packages in model)
Context Menu Right-click on Package > Package Control > Re-synch Status With VC Provider

(applies to single Package only)

Resynchronize version control status

Step Action

1 The results of the re-synchronization process are sent to the System Output window.
2 Double-click on any result message to select, in the Project Browser, the corresponding Package.
Notes

e This process does not cause any Package data to be either exported from your model to the associated Package file,
or imported from a Package file into your model's Package data

e Ifa Package has been checked-out and modified with Enterprise Architect, but your version control provider reports
the Package file as checked-in, running this process marks the Package within Enterprise Architect as being
checked-in, without exporting and committing the pending changes; subsequently checking-out the Package imports
the latest revision of the Package file from version control, effectively discarding the uncommitted modifications
from the model

e Similarly, if a Package file is checked-out to you in your local working copy folder, but not in the Enterprise
Architect model, running this process marks the Package within the model as checked-out, but it does not import the
associated Package file from the version control system; consequently, it is possible to check-in a Package from
Enterprise Architect that is potentially out of date, compared to the latest revision of the Package file within the
version control system
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Tracking Changes

If you want to track changes to data across your project, you can use two separate but complementary facilities -
Auditing and Baselines.

Facilities
Facility Detail
Auditing of model changes Auditing is a project-level feature, available in the Corporate, Business and

Software Engineering, System Engineering and Ultimate editions, that enables you
to record model changes in Enterprise Architect.

By enabling this feature, model administrators can view a range of information
regarding changes, such as:

e Who changed an element

e  How many elements they changed
e  When they changed the data

e  What the previous values were, and

e  What type of elements they changed

Baselining and differencing The Enterprise Architect Corporate, Business and Software Engineering, System

to capture and roll back Engineering and Ultimate editions provide a facility to ' baseline ' or snapshot a

changes model branch in XMI format at a particular point in time, and store it within the
model in compressed format.

More than one baseline can be stored against a single Enterprise Architect Package;
using baselines, you can compare Packages at the current and earlier stages of
development, using the Compare (Diff) utility.

The Compare utility is available in the Professional, Corporate, Business and
Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect; it enables you to compare the current model with:

e A Baseline
e An exported Enterprise Architect XMI file on disk
e A version-controlled Enterprise Architect XMI file on disk
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Auditing

Auditing is a project-level feature that model administrators can use to record model changes in Enterprise Architect.
After switching Auditing on, you can view information on changes such as:

o  Who changed an element

e How many elements they changed

e  When they changed the data

e  What the previous values were, and
e What type of elements they changed
Auditing does not record changes to:

e Document Templates

e Model Documents

e Baselines or

e  Profiles

We provide a Quickstart procedure to help you enable Auditing and see it in action, from which point you can explore a
number of set-up options and display features.

Features

Feature Detail

The Audit View To view what has been recorded by the audit, use the Audit View, which provides
an interface to everything recorded by Auditing.

If security is enabled, you must have Audit View permission to display data in the
Audit View.

Model Views You can also obtain a snapshot of selected items in the model, using the Model
View facility.

In the Corporate, Business and Software Engineering, Systems Engineering or
Ultimate editions of Enterprise Architect, you can use this facility to automatically
generate a snapshot at intervals and, if there are changes in the items collected by
the defined search, to trigger a notification to you of such changes.

This helps you to monitor workflow and other events of concern to you.

Document Report You can generate a document report that includes the audit history information for
the selected element or Package, by choosing the basic + audit template.

Audit History Using Auditing, you can track changes to an element or connector over time.

However, enabling Auditing also enables an 'Audit History' tab in the System
Output window, which summarizes all changes made to the selected element or
connector.

Performance Issues By enabling Auditing on a project, you increase the time taken for most actions.

For most modeling tasks, this increase is insignificant; however, there are some
instances where the difference is more substantial.
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Notes

e  The Auditing facility is available in the Corporate, Business and Software Engineering, System Engineering and
Ultimate editions

e  Warning - If your site runs separate editions of Enterprise Architect, when Auditing is turned on in a project any
Desktop or Professional edition users are locked out of the project; to restore access, turn Auditing off in the project
from the Corporate, Business and Software Engineering, Systems Engineering or Ultimate edition instance of
Enterprise Architect
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Auditing Quickstart

It is very simple to enable Auditing and see it in action.

30 June, 2017

Access
Ribbon Configure > Model > Audit : Audit Settings
Enable Auditing
Step Action
1 In the 'Audit View', click on the Audit Settings button.
The 'Audit Settings' dialog displays.
2 Select the 'Enable Auditing' checkbox.
3 Click on the OK button to close the 'Audit Settings' dialog.
4 Close the 'Audit View' dialog.
5 Change and save your project.
e Add a new Package
e Add anew Class
e Add a new connector
e Change the name of an element
e Delete an element
6 Open the Audit View again and click on the Refresh (or Load) button to display a record of the changes
you have made.
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Auditing Settings

Using the 'Audit Settings' dialog, you can change what is recorded by the Auditing facility and:
e Define the areas of processing in Enterprise Architect to audit

e Administer your audit records

e Indicate the kind of model objects for which changes are to be recorded

e Configure Auditing to record changes to only certain types of elements

Access

Ribbon Configure > Model > Audit : Audit Settings

Configure Settings

Option Action
Enable Auditing Select this checkbox to turn the Auditing facility on.
Audit XMI Import Select this checkbox to record changes arising from XMI importing in the audit.

As version control uses XMI, you must select this option to record changes from
checking out Packages.

Audit XMI Export Select this checkbox to record changes arising from XMI exporting in the audit.

As version control uses XMI, you must select this option to record changes from
checking out Packages.

Audit Reverse Engineering Select this checkbox to record changes arising from reverse engineering in the
audit.
Use Database Timestamp Select this checkbox to use the database server's timestamp instead of each user's

local timestamp; this improves security.

This option is not available for project files.

Clear Logs Click on this button to permanently delete all log data from the current project; use
the Save Logs button first, to save the audit records outside the project.

The system prompts you to specify whether to clear items logged over a specific
period of time.

e  Click on the No button to clear all log items currently held in the database

e  Click on the Yes button to display the 'Time Filter' dialog, on which you select
a standard time period or define your own

This function can be accessed through the Automation Interface.

Save Logs Click on this button to save a copy of the logged audit items currently held in the
project. These items remain in the project; you can use the Clear Logs button to
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Load Logs

Core

Standard

Extended

Debug

Maintenance

Core Structural
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remove them.

The system prompts you to specify whether to save items logged over a specific
period of time.

e  Click on the No button to save all log items currently held in the database

e  Click on the Yes button to display the 'Time Filter' dialog, on which you select
a standard time period or define your own

This function can be accessed through the Automation Interface.

Click on this button to load a previously saved set of logs back into the project. A
browser displays through which you select the log file to reload.

If the same record exists in both project and log file, that record is not reloaded.

Select this radio button to record changes to elements (including attributes and
operations), Packages, connectors and some model-level information.

Select this radio button to record the same changes as for the Core option, plus
changes to some of the 'housekeeping' data for diagrams - Name, Author, Version,
Stereotype, Notes and Date Modified.

You can check for changes to diagram content and structure using the Baseline
facility for reviewing visual changes to diagrams.

Select this radio button to record the same changes as for the 'Standard' option, plus
changes to project security.

Select this radio button to record the same changes as for the 'Extended' option plus
changes to any database tables. Some of the auditing information will not be visible
unless the Audit View mode is set to 'Raw'.

Select this radio button to audit changes to maintenance elements only; that is:
e Package (element)

e Requirement

e Feature

e Use Case

e Actor

e Note

e [ssue and

e Change

Select this radio button to audit changes to maintenance elements plus certain
structural elements; that is:

e Package (structure)
e (lass

e Interface

e Signal

e Node

e  Component
e Artifact

e Part

e Portand
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e Device
All Select this radio button to audit changes to all types of element.
Custom Select this radio button to audit changes to element types that you specify.

The Customize button is made available; click on this button to display a list of
element types, and select the checkbox against each element type to include in the
audit (or click on the Select All button to select every element type).

Click on the OK button to save the selection.

Notes

e As the number of records increases, the performance of the Audit View reduces; it is recommended that audit
records that are not regularly required are saved to file, then cleared from the project, to help ensure high
performance

e  Connectors are audited when they are connected to an element that is included in the Audit Options

e Ifsecurity is enabled, you must have Audit View permission to turn Auditing on, and Audit Settings permission to
change the audit settings

(c) Sparx Systems 2015 - 2017 Page 91 of 121 Created with Enterprise Architect



User Guide - Change Management 30 June, 2017

The Audit View

The Audit View provides an interface to the information that has been recorded by auditing.

Access

Ribbon Configure > Model > Audit

Sections of the Audit View

The Audit View is divided into three main areas:

Section Description

View controls The view controls provide a variety of settings for controlling auditing and the
display of audit records.

Audit tree The audit tree displays the log items that have been recorded by auditing.
What is displayed in the tree is affected by the view controls, such as:
e Sorting
e Filter (by time)
e Mode
e  Auditing settings (what was actually recorded)

If synchronizing with the Project Browser, it is also affected by the Package,
diagram or element you have selected.

=l [_] Class Elements
= MyClass
« 2007-03-13 10:33:55
¢ 2007-03-13 10:3%:01
% 2007-03-13 10:3%:04

In the audit tree:

e The green tick indicates a creation
e The yellow pencil indicates an edit
e The red cross indicates a deletion

Right-clicking an element in the audit tree (such as MyClass) displays a context
menu that enables you to locate the selected element in:

e The Project Browser

e Any diagrams in which it exists

Record display The record display is in two parts: the identity of the selected change, and the actual
change made.

The data in the record display is determined by the view controls and mode and, if
synchronizing with the Project Browser, by the Package, diagram or element you

(c) Sparx Systems 2015 - 2017 Page 92 of 121 Created with Enterprise Architect



User Guide - Change Management 30 June, 2017

have selected.

Identity

User  rchester{admin)
Time  2009-06-04 14:30:01
Details Package. (Class Model)

The identity of a change consists of:

e The Windows username of the user that made the change; if security is
enabled, the name is of the format WindowsUsername(SecurityUser)

e  When the change was made

e The path of the change; for example: Class Class] - Attribute Attl - Attribute
Constraint Constraint

Changes

Changes are displayed in a table format, showing the:

Property (or data item) name
Its original value before the change and

Its value after the change

If you double-click on an item in the list of changes (or right-click and select the
'Show Differences' option) the Difference window displays:

Before Change After Change
Proposed] Validated

This shows the specific changes that have been made, highlighting the edited,
created, deleted or formatted characters.

Changes to the format of text in the element, made through the element Properties'
dialog, are not apparent in the initial table; they are visible in the Difference
window, identified by HTML formatting tags.

Notes

e Ifsecurity is enabled, you must have Audit View permission to display data in the Audit View
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Audit View Controls

The Audit View controls provide a variety of settings for controlling auditing and the display of audit records.

Options

Option
Load or Refresh

Search

Audit Settings

Sort-by

Filter By Date/Time

Filter Settings

(c) Sparx Systems 2015 - 2017

Action

Click to reload the Audit Tree, updated with any new audit results.

Click to search through log items for a particular area - you can search by Name,
Type or GUID.

The items are loaded and filtered with the current Sort By, Time Filter and Mode
settings.

If you refresh the Audit View, you must run the search again.
Click to open the 'Audit Settings' dialog.

Select the appropriate radio button for the required display setting:

e Type - changes are grouped under element type (such as Class or
Requirement), and then grouped under the changed element

=l |_] Class Elements
= MyClass
«# 2007-03-13 10:33:55
¢ 2007-03-13 10:39:01
% 2007-03-13 10:39:04

e  User - changes are grouped under user name, each with the number of changes
for that user

Under each user name, changes are grouped as for the Type sort

= rﬁ'-,lz admin (3)
=I-__] Class Elements
= MyClass
«F 2007-03-13 10:46:06
¢ 2007-03-13 10:46:10
% 2007-03-13 10:46: 15

Select to enable the Filter Settings button, to filter the audit results by time period.

Changes that occur outside the selected filter period are not shown in the Audit
View.

Click to display the 'Time Filter' dialog, to set the filter time period:

e Today - to display changes occurring today

e  Previous Hour - to display changes occurring in the last 60 minutes
e Previous 24 Hours - to display changes occurring in the last 24 hours
e Previous Week - to display changes occurring in the last 7 days

e Previous 30 Days - to display changes occurring in the last 30 days

e Previous Year - to display changes occurring in the last 365 days
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e Custom - to define your own time period, using the From and To fields

The six pre-configured time periods automatically update when you click on the
Refresh button; custom periods are static and do not automatically update.

If you have set a filter period, and you deselect the 'Filter By Date/Time' checkbox,
the period remains set; the custom time period, too, is retained so that you can
re-use it or modify it later if required.

Status Text Read to see which:
e  Mode has been selected and

e Time filter is being applied to the data

Mode Click to display a menu of options to change the mode of the Audit View.
Select:

e 'Standard' - to automatically synchronize with the Project Browser; where
changes have been made, the Audit View reflects your selection from the
Project Browser - if you click on:

- An element, the Audit View displays the history for that element

- A Package, the Audit View displays the history for that Package and its
immediate children (but not the contents of nested Packages)

- A diagram, the Audit View displays the history for that diagram and its
contents (which could be drawn from a wide area of the Project Browser)

e 'Advanced' - to load large sets of log items independent of the Project Browser;
in this mode, a special Audit Settings group can be displayed in the Audit Tree,
which records:

- When Auditing has been enabled and disabled

- Who made the change

- The date and time of the change

- Changes to the Audit Settings

- When Audit Operations are executed

- Security changes (which can be browsed in the same way as other changes)

e 'Deleted' - to display only deleted records, but otherwise data is shown as in
'Advanced' mode; records can be sorted by element type or by user as required

e 'Raw' - to display all audit records in chronological order without sorting,
enabling you to see a progression of changes; this can be especially useful in
determining date-time inconsistencies
Any search and filtering you define still apply, enabling you to view all of
today’s changes in order, or all changes for a particular element in order, or
both
Additional database information is displayed; this additional information might
be insignificant or only in machine-readable format
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Audit History Tab

When Auditing is turned on, an 'Audit History' tab is enabled in the System Output window. The tab shows a history of
changes to whichever element or connector you have selected in the:

e Current diagram
e  Project Browser
e  Audit View, or

e Package Browser

As you select different elements or connectors, the 'Audit History' tab automatically updates to reflect your current
selection. For each change made to the element or connector, the tab shows:

e Who made the change

e When the change was made

o Where the change was made

e  The value of the characteristic before the change

e  The value of the characteristic after the change

Access

Ribbon Show > Window > System Output > Audit History

Notes

e To see this tab, you must have the Audit View open; the tab continues to display if you subsequently close the Audit
View

e If security is enabled, you must have Audit View permission to display data on the 'Audit History' tab
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Auditing Performance Issues

Enabling auditing on a project increases the time taken for most actions.

For most modeling tasks, this increase is insignificant; however, there are some situations where the difference is more
substantial.

Operation Delays

Operation Detail

Large Deletions Deleting large Packages or Package structures, or large numbers of elements, takes
significantly longer with auditing on.

You might disable auditing before performing such a deletion.

XMI Imports Importing XMI takes longer with auditing enabled.
A project-level option is provided for disabling auditing of XMI Imports.

Reverse Engineering Reverse engineering code takes longer with auditing enabled.

A project-level option is provided for disabling auditing of reverse engineering.

Replication You cannot remove replication from a model with Auditing enabled.

If you have to remove replication, disable Auditing and - if prompted to do so -
allow Enterprise Architect to roll back the database version; you can then remove
replication.
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Audit View Performance Issues

The Audit View can cause slow performance, generally because of the volume of records it has to process.

Considerations and Responses

Consideration Detail

Navigating the Project Try setting the time filter to a period in the immediate past, such as Today, Previous
Browser Within Auditing is 24 Hours or Previous Week; this time period updates each time you open or refresh
Slow the Audit View.

Save log items outside the project with the Save Logs button; if you then clear the
logs you have just saved, the load time of the Audit View is reduced.

You can reload logs into the project at any time, using the Load Logs button.

The Audit View is Slow in Try setting the time filter to a period in the immediate past, such as Today, Previous
Loading and Changing 24 Hours or Previous Week; this time period updates each time you open or refresh
Modes the Audit View.

Save log items outside the project with the Save Logs button; if you then clear the
logs you have just saved, the load time of the Audit View is reduced.

You can reload logs into the project at any time, using the Load Logs button.

Navigating the Audit Tree Close the 'Audit History' tab in the System Output window
is Slow

(c) Sparx Systems 2015 - 2017 Page 98 of 121 Created with Enterprise Architect



User Guide - Change Management 30 June, 2017

Package Baselines

Enterprise Architect includes tools to help you manage and review changes to your models over time. These tools apply
the concepts of Baselines, Differencing and Merges.

You use Baselines, Differencing and Merges essentially to compare two snapshots of a specific part of your project, to
capture the differences between them and either roll back or incorporate selected changes or all changes.

Baselines

Enterprise Architect provides a facility to create a Baseline or 'snapshot' of the contents of a selected Package and its
child Packages at a particular point in time; this enables you to later compare that branch of the model at that time with
the current state of the branch.

Baselines are stored in the same XML format as is used for version control, but are stored within the project in
compressed format.

You can also have parallel copies of parts of your model for team development, and create Baselines within each copy to
merge changes into the project master.

Differencing

Differencing (Diff, or Compare) helps you to explore the differences between:
e The current state of a specific part of your project, and

e  Previous or parallel versions captured in a Baseline or an XMI 1.1 file on disk

Merges

Once Differencing is complete, you can merge information from the Baseline into the current project; it is not possible to
go the other way.

You can:

e  Merge information manually, change by change

e Merge information automatically by electing to merge in all changes in one batch procedure
e Revert completely to the original Baseline by importing the stored XMI directly

e  Merge information and elements from a Baseline in a different project, making it possible to keep multiple versions
of a single model in synch

The merge options are available through the toolbar, context menus and the keyboard on the 'Compare Utility' tab, which
shows the results of a comparison.

Visual differences in diagrams

Changes to a model might include:
e Adding or removing elements and connectors on a diagram, or
e Changing the position of elements or the overall layout of a diagram

You might believe that a diagram has changed, and select to compare it with a baseline using a context menu option from
the Project Browser. Alternatively, you might perform a baseline comparison on a Package or a model and select from
the comparison output any diagrams that are flagged as changed.
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Notes

e Package Baseline facilities are available in the Corporate, Business and Software Engineering, Systems Engineering
and Ultimate editions of Enterprise Architect

e  The Enterprise Architect Corporate, Business and Software Engineering, System Engineering and Ultimate editions
provide another facility, Auditing, which you can switch on to perform continuous monitoring of changes across the
project; you can dovetail your use of each facility to meet the range of your change management requirements

e Ifa Package under version control forms part of a Baseline, and that Package is checked in to the model, you cannot
merge the original data from the Baseline into that Package

®  You can also obtain a snapshot of selected items in the model, using the Model Views facility; this facility enables
you to automatically generate the snapshot at intervals and, if there are changes in the items collected by the defined
search, to trigger a notification to you of such changes, which enables you to monitor workflow and other events of
concern to you

e Ifsecurity is enabled you must have 'Baselines - Manage' permission to crea